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Abstrakt  

 

Povodně jsou v současné době stále častěji se vyskytujícím jevem a úkolem 

dnešní společnosti je snižovat negativní dopady těchto událostí. Jako vhodný nástroj 

pro předcházení vzniku povodňových škod se jeví vytváření map povodňových 

nebezpečí a rizik, které podávají informace o průběhu hladiny vody v toku v případě 

zvýšených průtoků a určují míru ohroženosti řešeného území.  

Výstupem této diplomové práce jsou mapy povodňových nebezpečí a rizik 

pro obec Křešice na Litoměřicku. Proces se opírá o Metodiku tvorby map 

povodňových nebezpečí a rizik vydanou Výzkumným ústavem vodohospodářským 

T.G. Masaryka v Praze. Díky implementaci této metodiky na konkrétní lokalitu 

vznikne vlastní metodika práce, která nabídne uživatelům podrobný popis kroků ve 

specializovaném programu HEC-RAS a jeho extenzi HEC-GeoRAS. Tato diplomová 

práce se rovněž zabývá posouzením účinnosti protipovodňové stěny, která byla 

vybudována na ochranu obce. 

Samotné vyhotovení map povodňových nebezpečí a rizik je založeno na 

analýze zájmového území, zpracování hydrologických podkladů do podoby 

hydraulického modelu, následná vizualizace výsledků modelu a vytvoření plánu 

funkčních ploch v obci Křešice. Součástí práce je i literární rešerše zdrojů popisující 

problematiku vytváření map povodňových nebezpečí a rizik.  

 

Klíčová slova: záplavová území, povodně, hydraulický model, HEC-RAS, 

povodňové ohrožení  



 

 

Abstract 

 Floods are nowadays increasingly occurring phenomenon and task of our 

society is to reduce the negative impact of these events. As a suitable tool for the 

prevention of flood damage prevention seems to be creation of flood hazard and risk 

maps that provide information about the water level in the case of increased flows 

and determine the degree of vulnerability of the area. 

 The outcomes of this thesis are maps of flood hazard and risk for a village 

Křešice in the region of Litomeřice. The process is based on the Methodology of 

creation the flood hazard and risk maps issued by the Water Management Research 

Institute T.G. Masaryk in Prague. Through the implementation of this methodology 

to the specific place the personal work methodology will be created. This 

methodology offers users a detailed description of the steps in a specialized program 

HEC-RAS and its extension HEC-GeoRAS. This thesis also deals with assessing the 

effectiveness of flood walls, that were built to protect the village. 

 The actual preparation of flood hazard and risk maps is based on an analysis 

of the area, the processing of hydrological data into a hydraulic model , subsequent 

visualization of model results and creating a plan of functional areas in the village 

Křešice. The work also includes a literature review of sources describing the issue of 

creation of flood hazard and risk maps.  

 

Keywords: flood plains, floods, hydraulic model, HEC-RAS, flood threat   
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1. Úvod 

 Povodně a povodňové nebezpečí jsou aktuální problémy, kterým je velmi 

důležité věnovat pozornost, jelikož k povodňovým událostem dochází v dnešní době 

stále častěji. Povodně nejsou problémem posledních let, tento jev je přirozený  

a v minulosti na některých územích byl výskyt dokonce žádaný. V České republice 

jsou povodně způsobovány vysokými srážkovými úhrny a je pravděpodobné, že 

k povodním bude docházet častěji vzhledem ke globální změně klimatu, která 

přispívá i ke změně hydrologického cyklu.  

 Povodně představují ničivou hrozbu na majetku lidí a ohrožují na lidských 

životech. Proto je nezbytné snižovat povodňová rizika a zamezovat tak vzniku škod. 

Z tohoto důvodu se aplikují protipovodňová opatření. V intravilánu lze zastavěná 

území chránit různými technickými protipovodňovými opatřeními, a to například 

protipovodňovými stěnami, hrázemi a přehradami. V extravilánu by mělo docházet  

k takovým opatřením, která zpomalují povrchový odtok, podporují retenci  

a akumulaci vody v krajině a následně i její infiltraci do půdy. Mezi taková opatření 

patří různé zasakovací pásy, průlehy, suché poldry, protierozní nádrže a v první řadě 

vhodný vegetační pokryv krajiny.  

 Do opatření snižující potenciální objem škod patří i stanovení záplavových 

zón a následné rozhodování o využívání území v těchto zónách. Nedílnou součástí 

protipovodňové ochrany při krizových stavech je také dostupnost informací, 

funkčnost a operativnost lokálních výstražných systémů a připravenost jednotlivých 

záchranných složek. Tomu napomáhají právě mapy povodňových nebezpečí a rizik.  

 Povinnost vyhodnocovat povodňová nebezpečí toků je v současné době 

ukotvena v legislativě a to směrnicí Evropského parlamentu a Rady  

o vyhodnocování a zvládání povodňových rizik – ,,Directive of the European 

Parliament and of the Council on the assessment and management of flood risks". 

Tato směrnice ukládá členským státům za úkol vyhodnotit povodňová nebezpečí  

a rizika toků a formulovat je pomocí mapových výstupů (Drbal & kol., 2009). Plán 

hlavních povodí České republiky, který byl schválen vládou v květnu roku 2007, 

stanovuje řadu úkolů pro přípravu a realizaci protipovodňových opatření. Pro 

zajištění regionální či státní protipovodňové ochrany je nutné rozhodnout o tom, kde 

a jakým způsobem se budou provádět protipovodňová opatření a ochrana. Pro tyto 

účely slouží právě mapy povodňových nebezpečí a rizik, které pomohou určit, kde 

protipovodňovou ochranu realizovat a jak tedy optimalizovat využívání financí  

z veřejných prostředků (Drbal K. & kol., 2008). 

 Pro vyhotovení map povodňových nebezpečí a rizik je v možné uplatnit 

několik přístupů. Mezi takové patří integrace matematických modelů, které simulují 

průběh hladiny toku, s nástroji geoinformačních programů jako je například program 

ArcGIS. Výstupy z matematických modelů, které podávají informaci o možném 
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chování toku v případě N-letých průtoků, lze díky extenzím geoinformačních 

programů zpracovat a v závislosti na funkčním využívání území, které pramení  

z územního plánu obcí, vyhotovit grafické výstupy určující povodňová rizika  

v záplavových územích a následně spočítat výši potenciálních škod způsobených 

vybřežením toku do okolí (Drbal & kol., 2009).  

2. Cíle 

Cílem této diplomové práce je vyhotovení map povodňových nebezpečí  

a rizik a vytvoření vlastní metodiky popisující kroky a postupy práce související 

s danou problematikou. Mapy povodňových nebezpečí a rizik budou v diplomové 

práci vyhotoveny pro konkrétní místo - pro obec Křešice, která je v těsném kontaktu 

s řekou Labe a je velmi často povodněmi ohrožována. Samotnému vyhotovení těchto 

map bude předcházet zpracování prostorových a hydrologických informací pomocí 

hydraulického modelu pro Q5, Q20, Q100 a Q500, jehož výsledky budou následně 

vizualizovány do podoby rastrových map hloubek a rychlostí vody zasahující do 

území obce. Z těchto podkladů bude stanoveno povodňové nebezpečí. Po 

implementaci matice rizika do výstupů z hydraulického modelu bude vyjádřeno 

povodňového ohrožení obce na základě výpočtu intenzity povodně pro zkoumané 

povodňové scénáře. V dalším kroku bude vytvořena kategorizace funkčního využití 

ploch v řešeném území, na základě které se vyhotoví mapa zranitelnosti. Tato mapa 

zranitelnosti bude podkladem pro zpracování mapy povodňových rizik. Součástí 

práce je i vyčíslení škod pro návrhové průtoky Q100 a Q500.  

V obci je vybudována protipovodňová ochrana na Q20, proto bude v práci 

zhodnocena její účinnosti a výsledky budou porovnány se situací, kdy by obec 

protipovodňovou ochranou nedisponovala.   

 Práce se skládá ze dvou části - části teoretické a části praktické. V teoretické 

části bude popsána problematika tvorby map povodňového nebezpečí a rizik díky 

rešerši literárních zdrojů - prameny tedy představuje dostupná odborná literatura  

a metodiky výzkumných institucí. Mimo jiné teoretická část podá informace o obci, 

historii povodní na jejím území, rovněž popíše protipovodňovou ochranu Křešic.  

V praktické části budou aplikovány teoretické poznatky na vlastní vyhotovení map. 

Výsledkem praktické části bude tedy vlastní metodika popisující jednotlivé kroky při 

tvorbě map povodňového nebezpečí a rizik v dané obci. Praktická část bude 

zpracována rovněž za pomocí metodik, především se bude opírat o nejnovější 

metodiku pro danou problematiku – Metodiku tvorby map povodňových nebezpečí  

a rizik od Výzkumného ústavu vodohospodářského T.G. Masaryka a dále zkušeností 

dalších odborných institucí a to při využití softwarových aplikací ArcGIS a HEC-

RAS.   
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3. Literární rešerše 

3.1 Problematika map povodňových nebezpečí a rizik 

Mapy povodňových nebezpečí a rizik se vyjadřují charakteristikami průběhu 

povodně pro scénáře nebezpečí s kulminačními průtoky Q5, Q20, Q100, Q500. 

Podnětem pro vytváření map povodňového nebezpečí a povodňových rizik 

v České republice se stala směrnice EU 2007/60/ES o vyhodnocování a zvládání 

povodňových rizik. Dle této směrnice by měly být tyto mapy vyhotoveny pro 

zeměpisné oblasti, které jsou ohroženy povodněmi těchto typů: 

a) povodněmi s nízkou pravděpodobností výskytu nebo extrémní povodňové 

scénáře; 

b) povodněmi se středně vysokou pravděpodobností výskytu (pravděpodobná 

doba opakování ≥ 100 let); 

c) případně povodněmi s vysokou pravděpodobností výskytu; 

 

Předmětem směrnice je zvládání povodňových rizik s cílem snížit nepříznivé 

účinky na lidské zdraví, životní prostředí, kulturní dědictví a hospodářskou činnost, 

které souvisejí s povodněmi. Mapy povodňových nebezpečí a rizik mají být 

základem pro územní plánování a rozhodování ve veřejné správě, které korespondují 

se zvládáním povodňových rizik a protipovodňovou ochranou (Povodí Labe, 2009). 

3.1.1 Právní a legislativní vymezení 

 V listopadu roku 2002, několik měsíců po tom, co došlo v Evropě (Rakousku, 

České republice a Německu) k ničivým povodním, se členské státy dohodly na tom, 

že je nutné zlepšit povodňovou předpověď a prevenci. Díky tomuto impulsu vznikla 

skupina zvaná EXCIMAP, která dala vzniku příručce ,,Guide of best practices on 

flood prevention, protection and mitigation". V zásadě je tento dokument manuálem 

k tomu, jak předcházet a zvládat povodně a základní ideou tohoto projektu je výměna 

informací mezi okolními státy. Mimo jiné příručka rovněž obsahuje informace o typu 

povodní, pravděpodobnostech výskytu, transformaci povodňových vln a informace  

o tom, jak získat údaje o výších možných škod (EXCIMAP, 2007).  

 Předpokladem k efektivním a účinnému předcházení povodní  

a minimalizování škod po povodních je tedy znalost možných hrozeb a nebezpečí. 

Pro efektivní protipovodňové hospodaření je proto nutné vědět, jaký typ povodní 

může dané území sužovat, znát pravděpodobnost výskytu a rozsah případných 

povodní, výšky hladiny vody a její rychlosti při daných průtocích a v neposlední řadě 

také výši případných škod. Právě povodňové mapy jsou nástrojem pro podání 

takových informací - tedy možných rizik a nebezpečí. Tyto mapy určují, kde a jak 

využít nástroje pro prevenci vzniku povodní.  
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 Z pohledu Evropské unie v souvislosti s danou problematikou zvládání 

povodňových situací souvisí rámcová směrnice Evropského parlamentu a Rady 

2000/60/ES o vodní politice a dále směrnice 2007/60/ES o vyhodnocování a zvládání 

povodňových rizik. Ta členským státům ukládá povinnost vypracovat tyto tři 

dokumenty: 

 Posouzení předběžných povodňových rizik, 

 Mapy povodňových nebezpečí a rizik, 

 Plány řízení povodňových rizik (EXCIMAP, 2007). 

Definice: 

 Povodní se podle vodního zákona č. 254/2001 Sb., o vodách ve znění zákona 

č. 150/2010 Sb., o vodách, v platném znění; rozumí přechodné výrazné 

zvýšení hladiny vodních toků nebo jiných povrchových vod, při kterém voda 

již zaplavuje území mimo koryto vodního toku a může způsobit škody 

 Povodňovým rizikem se dle směrnice 2007/60/ES, o vyhodnocování  

a zvládání povodňových rizik, v platném znění, rozumí kombinace 

pravděpodobnosti výskytu povodně a možných nepříznivých účinků na lidské 

zdraví, životní prostředí, kulturní dědictví a hospodářskou činnost, které 

souvisejí s povodní 

 Povodňové nebezpečí charakterizuje stav s potenciálem způsobit nežádoucí 

následky (povodňové škody) v záplavovém území. Povodňové nebezpečí lze 

definovat také jako „hrozbu“ události (povodně), která vyvolá např. ztráty na 

lidských životech, škody na majetku, přírodě a krajině. Kvantifikace 

povodňového nebezpečí se provádí na základě hodnot charakteristik průběhu 

povodně (VÚV T.G.M., 2011) 

 Zranitelnost území je vlastnost území, která se projevuje jeho náchylností k 

poškození a škodám v důsledku malé odolnosti vůči extrémnímu zatížení 

povodní, tj. v důsledku tzv. expozice (VÚV T.G.M., 2011) 

 Mapy povodňového nebezpečí zobrazují místa, která by mohla být povodní 

zaplavena a rozdělují je do 3 kategorií, dle nebezpečí na místa málo, středně  

a vysoce ohrožená, s přihlédnutím na typ povodně, rozsah povodně, výšku 

vody, rychlost a směr proudění (EXCIMAP, 2007) 

 Mapy povodňových rizik určují možné negativní povodňové následky  

s ohledem na počet ohrožených obyvatel, typ území a objektů popřípadě 

zasažených povodní (EXCIMAP, 2007) 

3.1.2 Vyjádření povodňového rizika 

 Povodňová rizika jsou vyjadřována pro různou hierarchii územních celků  

a skupin ohrožených objektů a to pro nebezpečí vznikající z povodňových scénářů 

s kulminačními průtoky Q5, Q20, Q100, Q500. Přístup k určení povodňových rizik je 

různý, nejčastěji se však povodňová rizika vyjadřují pomocí semikvantitativní  

a kvantitativní analýzy (Drbal & kol., 2009).  
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 Semikvantitativní hodnocení – vyjadřuje riziko na základě stupnice – 

numerické, nebo barevné. Výsledkem této analýzy je vyjádření relativní výše rizika. 

Jako příklad tohoto přístupu lze uvést metody vycházející z vyjádření maximálního 

přijatelného rizika nebo metody založené na matici rizika (Drbal & kol., 2009).  

 Kvantitativní hodnocení – na základě pravděpodobnosti výskytu stavu 

jednotlivých prvků systému je stanovena pravděpodobnost finálního stavu celého 

systému a tím je rovněž vyjádřena jeho spolehlivost (Drbal & kol., 2009). Tato 

metoda vyjadřuje riziko v měrných jednotkách (v peněžních jednotkách, počet úmrtí 

a podobně). Jako běžně používanou metodou kvantitativního přístupu lze uvést 

postup, který vychází ze stanovení potenciálních škod. Základem metody je 

ohodnocení možného povodňového nebezpečí, zranitelnosti území a ekonomických 

škod.  

3.2 Povodňové riziko – semikvantitativní přístup 

 Způsob, kterým lze plošně hodnotit povodňové nebezpečí, zranitelnost  

a následná rizika je prováděno pomocí metody matice rizika (Říha & kol. 2005; 

Drbal & kol.; 2009, Dráb, 2010). Tato metoda definuje povodňové ohrožení jako 

funkci intenzity povodně, která vyjadřuje povodňové nebezpečí. Metoda spočívá 

v těchto krocích:  

 Kvantifikace povodňového nebezpečí – výpočet intenzity povodně na základě 

hloubek a rychlosti proudění vody 

 Stanovení povodňového ohrožení - pomocí matice rizika 

 Stanovení zranitelnosti území – podle územního plánu 

(Dráb, 2010) 

Kvantifikace povodňového nebezpečí 

 Povodňové nebezpečí je vyjádřeno tzv. charakteristikami průběhu povodně 

pro scénáře nebezpečí s kulminačními průtoky Q5, Q20, Q100, Q500. Tyto 

charakteristiky podávají informace o rozsahu rozlivů, hloubkách zaplavení  

a rychlostech proudění vody. Pro vyjádření povodňového nebezpečí se určuje 

prostorové rozdělení popsaných charakteristik (Drbal & kol., 2009; Dráb, 2010).  

 Pro vyhodnocení povodňového nebezpečí se využívá výsledků 

z hydraulického modelu toku - hloubek vody a rychlosti proudění při daných 

povodňových scénářích. Výsledky hydraulických výpočtů se poté graficky 

vypracovávají v programu ArcGIS a to díky extenzi HEC-GeoRAS. Výstupem jsou 

následně mapy, které barevnou škálou popisují míru ohroženosti místa povodněmi na 

základě hloubky zaplavení a rychlosti proudění vody. Povodňové nebezpečí je 

nejčastěji vyjadřováno pomocí intenzity povodně IP.  

Při kvantifikaci nebezpečí způsobeného povodněmi je nebezpečí definováno 

veličinou intenzity povodně IP. Tato veličina představuje míru ničivosti povodně a je 

funkcí hloubky vody h [m] a rychlosti proudění vody v [m/s] (Beffa, 2000; Drbal & 
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kol., 2005; Říha & kol., 2005). Z hodnot představujících hloubku a rychlost proudění 

vody se získají hodnoty intenzity povodně IP po implementaci následující matice 

rizika:  

IP =    {
      

                       

                    
} 

(Drbal & kol., 2009) 

 Vstupními daty pro výpočet intenzity povodně jsou tedy hodnoty hloubek  

a rychlostí vody pro uvažované N-leté průtoky v řešeném území. Prostorové 

rozložení těchto hodnot je dáno rastry hloubek a rychlostí, které je možné získat po 

vypracování hydraulického modelu a to z jeho výsledků v prostředí HEC-GeoRAS. 

Výpočet IP je potřebné provést pro všechny sledované scénáře povodňového 

nebezpečí (pro Q5, Q20, Q100 a Q500) (Drbal & kol., 2009). 

 Výsledkem těchto výpočtů jsou rastrová data (gridy), ve kterých má každá 

buňka rastru údaj o intenzitě povodně IP pro jednotlivé povodňové scénáře (Drbal & 

kol., 2009).  

Stanovení povodňového ohrožení 

Míra ohroženosti Hi(x,y) vychází z hodnot intenzity povodně IP pro každý ze 

zkoumaných povodňových scénářů. Ohrožení Hi(x,y) při daném povodňovém scénáři 

Qi(Pi) je v určitém místě (se souřadnicemi x, y) řešeného území vyjádřeno jako 

funkce pravděpodobnosti Pi výskytu daného povodňového scénáře (při stanovené N-

letosti kulminačního průtoku) a intenzity povodně IPi(x,y) (Beffa, 2000):  

 

Hi(x,y) = IPi(x,y) . Pi 

kde 

Pi = 1 – e
(-1/N)

, resp. Pi = 1/N pro velká N (cca N > 10) 

N je doba opakování povodňové událost v rocích 

 

Na základě hodnot intenzity povodně IP a době opakování N (v letech) je 

potřebné určit míru ohrožení a toto ohrožení klasifikovat do 4 kategorií a to 

v rozmezí od 1 (reziduální) do 4 (vysoké), viz obrázek č. 1 (Drbal K. & kol., 2008).  
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Obrázek č. 1, Grafické vyjádření povodňového ohrožení, (Drbal & kol., 2009) 

Stanovení zranitelnosti území 

 Informace o způsobu využití území vycházející z digitální grafické části 

územně plánovací dokumentace tvoří základní podklad pro stanovení zranitelnosti 

území. V případě, že zkoumaná obec nemá vyhotovený digitální územní plán, nebo 

je územní plán neaktuální, se zranitelnost území určuje na základě jiných zdrojů 

informací jako je například základní mapa (ZABAGED), katastrální mapa, 

internetové stránky obce, terénní průzkum atd. Pro stanovení zranitelnosti řešeného 

území se funkční plochy v daném místě rozdělují do uvedených kategorií dle 

obrázku č. 2 ve třech časových aspektech pro stav současný, návrhový a výhledový  

a zároveň se pro účely jednotnosti při vytváření ploch zranitelnosti v grafických 

programech využívají tato barevná rozlišení: 

 

Obrázek č. 2, Barvy a výplně jednotlivých kategorií funkčních ploch pro určení zranitelnosti 

území (Drbal K. & kol., 2008) 

 V souvislosti s rizikovou analýzou území je potřebné v některých kategoriích 

funkčního využití ploch znázornit tzv. citlivé objekty. Jako citlivé objekty jsou 

označována místa, ve kterých dochází ke zvýšené koncentraci obyvatel, jež mají 
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specifické potřeby při případné evakuaci (školy, nemocnice, ústavy sociální péče 

atd.) nebo zařízení, která zabezpečují fungování obce a jejichž vyřazení z provozu by 

znamenalo omezení této funkčnosti (čistírny odpadních vod, úpravny vod, 

trafostanice, tlakové stanice plynu atd.) (Drbal & kol., 2009). Kategorie a označení 

jsou patrné na obrázku č. 3: 

 

 

Obrázek č. 3, Označení kategorií citlivých objekt, (Drbal & kol., 2009) 

Stanovení povodňového rizika 

 Pro vyhodnocení povodňového rizika je využíváno průniku informací  

o povodňovém ohrožení a zranitelnosti území. Na základě jednotlivých kategorií 

zranitelnosti území je stanovena míra přijatelného rizika (Drbal & kol., 2009). Mapy 

povodňového rizika poté znázorňují plochy, které jsou barevně vyšrafovány dle 

přijatelného rizika podle kategorií uvedených v tabulce č. 1.   

 

 

Tabulka č. 1, Míra přijatelného rizika (Drbal & kol., 2009) 

3.3 Povodňové riziko – kvantitativní přístup 

 Stanovení potenciálních škod se provádí pro movitý i nemovitý majetek, 

krajinné i přírodní hodnoty v inundačním území. Škody vyjadřují rozsah poškození, 

oběti na životech, lidská zranění, ekonomické ztráty a podobně. Základním dělení 

povodňových škod je na materiální a nehmotné, přičemž materiální škody jsou dále 
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rozřazeny na přímé a nepřímé. Nepřímé škody jsou dlouhodobějšího charakteru na 

regionální úrovni a mohou způsobovat například snížení hospodářského růstu dané 

oblasti vlivem působení škod přímých. 

Do kategorie přímých škod patří škody na bytovém fondu a jeho vybavenosti, 

škody na občanské vybavenosti (školy, nemocnice, kulturní dědictví, sportoviště), 

dopravní infrastruktuře (silnice, železniční trati, mosty, nádraží, dopravní 

prostředky), inženýrských sítích, vodním hospodářství (vodní díla, koryta toků, 

čistírny odpadních vod), zemědělství (objekty pro pěstování rostlin a zvířat), lesním 

hospodářství (produkční lesy, rekreační lesy), průmyslu, energetice a službách 

(elektrárny, trafostanice, těžba surovin) (Drbal & kol., 2009).  

3.4 Data potřebná pro tvorbu map povodňových nebezpečí a rizik 

3.4.1 Digitální model terénu 

 Digitální model terénu (DMT) reprezentuje reliéfové poměry území. 

Digitální model terénu je základním podkladem pro vyhotovení příčných profilů 

koryta toku a inundačním územím a pro následné stanovení hloubek vody zaplavující 

toto území při jednotlivých N-letých průtocích. DMT je možné získat pomocí 

LiDAR snímkování, z digitálních satelitních map a podobně (EXCIMAP, 2007). Pro 

tvorbu DMT se používají výšková data, která pokrývají danou oblast pouze v bodech 

nebo ve vrstevnicích. Pro kompletní prezentaci povrchu se využívají interpolační 

metody, které simulují tvar reálného terénu. Kvalita výstupního DMT se tedy odvíjí 

od kvality vstupních dat a také od zvoleného druhu interpolační metody. Jednou  

z možností získání souvislého povrchu reprezentující nadmořské výšky v území je 

metoda TIN (triangulated irregular network - nepravidelná trojúhelníková síť). 

Povrch je reprezentován sítí trojúhelníků, jejichž hodnota je vypočítána interpolací 

ze vstupních dat (Oršulák & kol., 2010). 

3.4.2 Mapové podklady 

 Mapové podklady se využívají především jako podklad pro určení funkčního 

využití ploch řešeného území nebo jako podklad pro vytvořené mapové výstupy  

a jejich prezentaci.  

 

 ZABAGED – je základní mapový podklad v měřítku 1:5 000 nebo 1:10 000 

v souřadnicovém systému S-JTSK. Polohopisná část poskytuje prostorové  

a popisné informace o sídlech, komunikacích, rozvodných sítích  

a produktovodech, vodstvu, územních jednotkách a chráněných územích, 

vegetaci a povrchu, terénním reliéfu. Její součástí jsou i vybrané údaje  

o geodetických bodech na území ČR (ČUZK, 2010). Mapové podklady 

ZABAGED se používají jako nástroj pro identifikaci objektů v záplavovém 

území při odhadu výše škod na hmotném majetku (Drbal & kol., 2009). 
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 Ortofotomapy - rovněž mohou sloužit jako podklad pro výsledné výstupy  

z modelování nebo pro určení objektů v řešeném území. Jsou vhodným 

vodítkem pro určení druhů povrchů a rozmístění vegetace ve sledovaném 

území (Drbal & kol., 2009). 

3.4.3 Terénní průzkum území  

 Terénní průzkum území tvoří velmi důležitou část při vytváření numerického 

modelu. Jedním z důvodů rekognoskace terénu je stanovení objektů důležitých při 

tvorbě hydrodynamického modelu jako jsou terénní překážky či velké stavební 

celky, vlastnosti a tvar povrchu a jeho drsnostní součinitel. Tyto charakteristiky mají 

vliv na plochu rozlivu a rychlosti proudící vody a proto je nutné je při modelování 

modelu vzít v potaz (Drbal & kol., 2009). 

3.4.4 Geodetické podklady 

Geodetické podklady jsou základním podkladem pro hydraulické modelování 

i pro vyhodnocení míry zaplavení území. Mezi tyto podklady patří geometrie 

vodního toku, geometrie objektů na vodním toku a geometrie inundačního území.  

3.4.5 Hydrologická data 

Hydrologické údaje jsou představovány informacemi o N-letých průtocích 

povrchových vod pro povodňové scénáře s dobou opakování 5, 20, 100 a 500 let 

v horním a dolním profilu sledované části vodního toku a v místě všech významných 

přítoků (Drbal & kol., 2009).  

3.4.6 Historická data 

Historická data hrají důležitou roli při kalibraci povodňových modelů. Mezi 

takové údaje patří povodňové mapy, záznamy o výšce vody a rychlosti proudění při 

předchozích povodních, historické zprávy, obrázky, dokumenty, ortofoto mapy, 

historické N-leté průtoky a povodňové značky v terénu (EXCIMAP, 2007). 

3.4.7 Kalibrační podklady  

Jako kalibrační údaje jsou uváděny záznamy o minulých povodních, 

maximální hladiny, velikosti kulminačních průtoků, záplavové čáry a podobně 

(EXCIMAP, 2007). 

3.4.8 Hydraulické modely 

 Hydraulické modelování slouží primárně pro předpověď situací a odhadování 

důležitých informací spojených s výskytem povodňové události. Takové informace 

jsou tvořeny rozsahem potenciálně zaplaveného území, hloubkami a rychlostmi vody 

v území. Hydraulický model predikuje zmíněné charakteristiky na základě 

zpracování vstupních dat. Vstupy představují údaje o morfologii terénu, N-letých 

průtocích, geometrii toku a hodnotách drsnosti řešeného území. V současné době se 

pro vytvoření takového modelu využívají 1D, 1,5D nebo 2D modely. Výběr závisí na 
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charakteristikách a místních podmínkách řešeného toku. Hydraulické modely je 

možno vytvořit například v softwaru Mike 11 nebo v programu HEC-RAS 

(EXCIMAP, 2007).  Výstupem hydraulických modelů jsou hodnoty, které se dále 

graficky zpracují do podoby map povodňových nebezpečí a rizik. 

Jednorozměrné (1D) modely - výhodou těchto modelů je jejich jednoduchost 

při vytváření, schematizace toku a snadná kontrola výstupů. Při použití 1D modelu 

pro simulaci proudění toku se vychází ze soustavy příčných profilů aplikovaných na 

vyšetřovanou délku toku. V tomto případě se předpokládá, že proudění probíhá mezi 

spojnicemi jednotlivých příčných profilů a proudění lze popsat v každém z profilů 

dle střední průřezové rychlosti a polohy hladiny ve směru osy koryta. Jednorozměrný 

model lze využít v případě koryt toků, které jsou charakteristické pravidelným 

tvarem koryta, úroveň hladiny v příčném směru je konstantní a proudění v toku  

a inundačním území je paralelní, celkově je proudění v korytě charakterizováno jako 

proudění ustálené (Drbal & kol., 2009). 

 Kvazi-dvourozměrné (1,5D) modely - zásadou těchto modelů je využití 

jednodušších principů jednorozměrného modelování před principy složitějšího 

dvourozměrného modelováním i v geometricky složitějších inundačních územích. 

Při vytváření tohoto modelu se území schematizuje větvenou či okruhovou sítí. 

Tento postup je vhodný pro řešení tehdy, kdy je možné dopředu s jistotou určit 

hlavní směry proudění vody v korytě. Je nutné znát přesná místa nátoků, výtoků  

z dešťových kanalizačních sítí a jiných objektů, které mohou mít vliv na směry 

proudění v toku nebo inundačním území. Pokud není možné proudění v některých 

částech řešeného území jednoznačně určit, tento model by neměl být pro řešení 

úlohy vybrán (DRBAL & kol. 2009). 

 Dvourozměrné (2D) modely - přístup těchto modelů je odlišný od 1D a 1,5D 

modelů v tom, že řeší oblast toku v podobě spojitého digitálního modelu terénu. 

Hodí se tedy pro toky, kde dochází k neustálenému proudění tedy v případech 

nepravidelných koryt, náhonů, hrází atd. Dvourozměrné modely poskytují velmi 

podrobné výstupy, přirozeně jsou tedy náročnější na vstupní data (Drbal & kol., 

2009). 

3.5 Nepřesnost mapování 

 Povodňové mapování není exaktní věda. V tomto ohledu je zde jistá míra 

nepřesnosti u každého modelování a mapování povodňových nebezpečí a rizik.  

V podstatě jsou zde dva důvody způsobující nepřesnosti mapování a to nepřesnosti 

spojené s přírodními jevy, hydrologií a klimatem. Další nepřesnosti mohou být 

způsobeny při získávání dat, vytváření modelů a při měření (EXCIMAP, 2007). 

 V zásadě existuje široká škála dostupných vědeckých metod pro stanovení 

těchto nepřesností. Mnoho z nich je ale velmi složité použít v případě tvorby map 

povodňových nebezpečí a rizik. Jako alternativní přístup je možné stanovit 

nepřesnost skrz kvalitativní přístup, který je založený na kvalitě a možnosti získání 
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kalibračních dat, hydrologických a hydraulických metod a vstupních dat 

(EXCIMAP, 2007). 

3.6 Využívaný software 

Ke zpracování dat a získání výsledků pro tuto diplomovou práci bude 

využíván program HEC-RAS 4.1.0, ArcMap 10.1 a jeho extenze HEC-GeoRAS 

10.1. 

 ArcMap je platforma, díky níž lze vizualizovat, zpracovávat a provádět 

analýzy prostorových informací. Extenzí programu ArcMap je platforma HEC-

GeoRAS, ve které dojde k editaci geometrických charakteristik a příčných profilů 

zvolené část vodního toku Labe a k následné vizualizaci výsledků 

hydrodynamického modelu z prostředí HEC-RAS.   

Neméně důležitým softwarem pro stanovení potenciálně zaplaveného území 

je program HEC-RAS. Tento program byl vyvinut inženýry Americké armády. 

Vytváří hydrodynamický 1,5D model ustáleného a neustáleného proudění pro 

zkoumaný vodní tok nebo jeho část. HEC-RAS při výpočtu zohledňuje drsnost 

prostředí jednotlivých profilů a vstupem, na kterém závisí pozdější výpočet, jsou 

vybrané N-leté průtoky a okrajové podmínky, které uživatel nadefinuje (Evans & 

kol., 1999). Systém je vybaven rozhraním pro grafickou a analýzu a prezentaci dat, 

které se do tohoto systému importují po předchozím zpracování shapefilových vrstev 

v program ArcMap, dále nástroji pro hydraulickou analýzu a nástroji pro ukládání 

získaných výpočtů. HEC-RAS se rovněž využívá pro stanovení sedimentačních  

a transportních procesů ve vodních tocích (Brunner, 2010a). 

V zásadě zde tedy funguje spolupráce mezi HEC-GeoRAS a HEC-RAS 

programy a to tak, že HEC-GeoRAS importuje výškové údaje z digitálního modelu 

terénu a geometrické údaje ze shapefile vrstev jako je například osa toku, břehy nebo 

příčné řezy územím. Následně HEC-RAS zpracuje vstupy z HEC-GeoRAS a vytváří 

neúplný model možného zaplavení území. Posléze uživatel doplní model přidáním 

hydraulických informací, jako jsou N-leté průtoky, okrajové podmínky a drsnost 

prostředí. Poté lze dopočítat hydraulický model v prostředí HEC-RAS a výsledná 

data mohou být importována zpět do prostředí HEC-GeoRAS a v něm vizualizována. 

Mezi výstupy, které se vizualizují, patří mapy rozlivů a hloubky a rychlosti proudící 

vody v záplavovém území (Evans & kol., 1999).  Detailní popis kroků při práci se 

zmíněnými programy je uveden v metodice práce.  

4. Metodika 

V České republice doposud neexistuje komplexní volně dostupná metodika, 

která by nabídla návod na postup při zpracovávání hydrologických podkladů 

v prostředí freeware programů HEC-RAS a HEC-GeoRAS pro vytvoření map 

povodňových nebezpečí a rizik. Vzhledem k tomu, že jsou tyto programy vytvořeny 
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Armádou Spojených států amerických, vyžadují určité přenastavení českého systému 

Windows a problémy, které se vyskytují při používání tohoto software, zatím nejsou 

kompletně popsány.  

Pro obec Křešice jsou mapy povodňových nebezpečí a rizik vyhotoveny 

firmou DHI a.s., která jej zpracovala v programu MIKE 11. Porovnáním výsledků 

z různých platforem lze ověřit správnost výsledků a zároveň odhalit odchylky ve 

výsledcích z různých programů.   

4.1 Řešené území 

 Mapy povodňových nebezpečí a rizik budou vyhotoveny pro obec Křešice. 

Obec se nachází na severovýchodě Čech v okrese města Litoměřice v Ústeckém kraji 

(obrázek č. 4). Katastrální území obce je tvořeno z několika částí - z částí Křešice, 

Záhořany, Třeboutice, Nučnice a Sedlec. Plocha všech částí obce představuje 1.1 tis 

ha (OÚ Křešice, 2014). V obci žije asi 1400 obyvatel. Katastrální území obce je 

převážně tvořeno zemědělskými plochami, trvalým travním porostem, lesním 

porostem a v menší míře zastavěnými plochami se zahradami.  Zájmové území je 

rovinaté s malým spádem, v katastrálním území obce se nachází vyvýšený terén 

pojmenovaný Křemín, kde nadmořská výška dosahuje 250 m n.m. 

Občanská vybavenost je na dostačující úrovni odpovídající menší obci.  

V obci je občanům k dispozici mateřská a základní škola. Disponuje zde sbor 

dobrovolných hasičů a městská policie. K občanské vybavenosti obce rovněž 

přispívá knihovna, pošta, obecní úřad a ordinací lékaře. V Křešicích je možné 

využívat hřiště a restauraci.  

 Původní historická zástavba obce - kostel Nejsvětější trojice, kostel Panny 

Marie a kostel sv. Matouše představují kulturní hodnoty obce. V obci je také hřbitov.  

 Technická vybavenost je v obci zajišťována díky veřejné kanalizaci, 

vodovodu, plynovodu a silnici II. třídy, která spojuje obec s Litoměřicemi. Doprava 

do obce je zabezpečována autobusovými linkami a železničním spojením, na území 

obce se nachází nádraží.  

 Díky úrodným půdám se v obci uplatňuje zemědělská malovýroba, pracovní 

možnosti nabízí textilní závod Schoeller (PROXIMA, 2009). 
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Obrázek č. 4, Zájmové území 

Klimatické charakteristiky 

Obec Křešice leží v teplé klimatické oblasti T2, která se vyznačuje dlouhým, 

teplým a suchým létem s průměrnou teplotou 18.5   C. Jaro a podzim je velmi krátké 

teplé. Zima je také krátká, suchá až velmi suchá, mírně teplá, trvání sněhové 

pokrývky je krátké, průměrná teplota v zimním období se pohybuje kolem -2.5   C. 

Průměrná roční teplota obce činí 8   C. Průměrný srážkový úhrn oblasti je naměřen na 

500 – 550 mm, přičemž nejvyššího srážkového úhrnu je dosahováno v červnu, 

červenci a srpnu (Starý, 2007).  

Pedologické a geologické charakteristiky 

V oblasti převažují černozemně, hnědé půdy a rendziny. V oblasti se 

vyskytují i takzvané antropogenní půdy, které vznikly devastací a stavební činností či 

skládkováním odpadů. Zájmové území leží v prostoru České svrchnokřídové tabule, 

nejdůležitějším horninovým celkem jsou svrchnokřídové sedimenty.  

Hydrologické vlastnosti 

Území Křešic patří pod povodí Labe, kde číslo hydrologického pořadí je  

1-12-03-069 až 1-12-03-073. Z hydrogeologického hlediska je území obce zařazeno 

do rajónu 452 – Křída pravostranných přítoků Labe. Charakteristikou území je 

vícekolektorový zvodnělý systém. Hluboko uložené křídové pískovcové kolektory 

s napjatou hladinou podzemní vody, tvořené především kolektorem cenomanským, 

mají značný vodárenský význam (Herčík & kol., 1999).  

Obec má velmi nepříznivou polohu vzhledem k možným výskytům povodní, 

protože se rozkládá v bezprostředním kontaktu s řekou Labe a to na jejím pravém 

břehu. Úsek Labe, na kterém bude prováděna analýza, je vymezen 795.9 až 801.6 

říčním kilometrem. Obcí dále protéká Blatenský a Luční potok, které mohou při 
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povodňových situacích rovněž negativně přispívat. Vzhledem k tomu, že řeka Labe 

má ale mnohonásobně větší povodí než tyto drobné toky, při extrémní hydrologické 

situaci má tedy na ohroženost obce zásadní vliv právě řeka Labe a proto bude vliv na 

ohrožení obce povodněmi v této obci posuzován dle N-letých průtoků pro úsek řeky 

Labe. Informace o N-letých průtocích na webových stránkách Českého 

hydrometeorologického ústavu pro měrnou stanici Mělník dle tabulky č. 2.   

 

N-leté průtoky [m
 
.s

- 
] 

Q1 Q2 Q5 Q10 Q20 Q50 Q100 

1080 1490 2060 2520 2990 3640 4150 

Tabulka č. 2, N-leté průtoky pro měrnou stanici Mělník (ČHMÚ, 2014) 

Jako hodnota průtoku Q500 se uvádí údaj o povodni z roku 2002, která 

Křešice zasáhla. Hodnota tohoto průtoku je stanovena na hodnotu 5070 m
3
.s

-1
. 

4.1.1 Historie povodní 

 Obec Křešice vzhledem ke své nepříznivé poloze zažila v novodobých 

dějinách ničivé povodně již několikrát. První povodní, která způsobila vysoké škody, 

jak uvádí kronika obce, byla povodeň v roce 1821. Poté do roku 1940 následovala 

řada osmi povodní s průměrnou dobou opakování po 13,5 letech. V historii obce 

zatím nejničivější povodeň přišla v roce 2002, kdy byl v Labi překročen průtok 5 300 

m
3
, který je klasifikován jako průtok Q500. Od roku 2002 se do roku 2013 vyskytly 

další čtyři povodňové události po průměrné době opakování 3 let. V roce 2006 byla 

vesnice opět zasažena povodní s podobným charakterem jako v roce 2002, ale 

s menším rozsahem zaplavení, než v roce 2002. V roce 2013 se situace znovu 

přiblížila stavu v roce 2002, ovšem výška hladiny vody z roku 2002 překonána 

nebyla. (Pála, 2013). Při většině povodňových událostí byly zasaženy domy ležící  

v blízkosti řeky Labe pro jeho zvýšenou hladinu, v případech rozlivů při Q100 a Q500 

byla potom ohrožena většina území Křešic. Na obrázku č. 5 jsou patrné povodňové 

stopy po minulých povodních (fotodokumentace březen 2014).   
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Obrázek č. 5, Povodňové stopy po minulých povodních (zdroj mapových podkladů: ČUZK, 

fotodokumentace: vlastní archiv) 

4.1.2 Protipovodňová ochrana obce 

 Podnětem k vybudování protipovodňové ochrany v obci byla povodeň z roku 

2002, kdy byla zaplavena převážná část obce a hladina Labe tehdy dosáhla nejvyšší 

úrovně v historii Křešic a také povodeň z roku 2006, při které průtok Labe dosáhl 

hodnoty Q20. Reakcí na tyto katastrofální povodně byla odezva Ministerstva 

zemědělství, kdy byl na jeho podnět zahájen dotační program 129 120 „Podpora 

prevence před povodněmi II. na období 2007–2012". Tyto finanční prostředky, které 

jsou investovány státním podnikem Povodí Labe, státní podnik, umožnily vybudovat 

protipovodňovou ochranu pro region dolního Labe, tedy i pro obec Křešice.  

 Vzhledem k místním podmínkám obce Křešice byly v obci navrženy jako 

protipovodňová opatření trvalé betonové zdi za současného využití mobilních prvků. 

Protipovodňové opatření je navrženo na Q20. Ochrana na vyšší návrhový průtok by 

v podstatě oddělila vizuálně obec od řeky Labe a byla by velice technicky náročná na 

provedení. Navrhované zdi v kombinaci s mobilními stěnami zajistí ochranu obce 

před rozlivem vody. 

 Betonové zdi se skládají ze spodní stavby, nadzemní části a mobilního 

hrazení. Spodní stavba je tvořena trvalou konstrukcí s těsnící statickou funkcí. 

Hloubka nadzemní části je navržena podle místních průsakových a stabilních 

poměrů. Další funkcí podzemní části stavby je statická funkce, jelikož díky této 

konstrukci dochází k přenesení vodorovných sil a momentů od zatížení nadzemní 



 

26 

 

části konstrukce PPO vodním tlakem do podloží. Nadzemní část je tedy tvořena 

betonovou stěnou ve výšce od 0.20m – 2.95m, jak je patrné z obrázku č. 6 a obrázku 

č. 7. V místech vjezdů, přechodů komunikací a přístupů na pozemky jsou 

navrhovány mobilní protipovodňové stěny (obrázek č. 8). Část protipovodňové 

ochrany je řešena i instalací pytlů s pískem. V případě přetečení protipovodňových 

bariér a tedy pro účely odvedení vnitřních vod budou spuštěna čerpadla, která budou 

vodu přečerpávat za linii bariéry (Povodí Labe, 2014a).  

 

 

Obrázek č. 6, Protipovodňová stěna v těsné blízkosti řeky (vlastní archiv) 

 

Obrázek č. 7, Protipovodňová stěna v obci (vlastní archiv) 
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Obrázek č. 8, Mobilní protipovodňová ochrana v místech přístupů na pozemky, 

http://www.hgpartner.cz/images/aktuality/a01.jpg 

 Celková délka linie různých druhů protipovodňového opatření je 2328.72m. 

Stěna má obec chránit před Q20, při kterém hladina vody dosahuje 150.24-150.61 m 

n.m. Celkové náklady na stavbu činily 193.7 mil. Kč. Investor, kterým byl státní 

podnik Povodí Labe, započal stavbu v červenci roku 2009 a dokončil v červenci roku 

2011 (Povodí Labe, 2014). Na obrázku č. 9 je patrný příčný řez protipovodňovou 

stěnou.  

 

 

Obrázek č. 9, Příčný řez protipovodňovou stěnou, (Zídek, 2011) 
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4.2 Práce s ArcMap 

 Zeměměřičský úřad poskytl digitální model reliéfu 5. generace (DMR 5G) ve 

formě nepravidelné sítě bodů, který vzniká pomocí leteckého laserového skenování 

s úplnou střední chybou výšky 0.18 m v odkrytém terénu a 0.30 m v zalesněném 

terénu (Brázdl & kol., 2012). Z této datové sady bylo možné vytvořit pomocí 

nástrojů v ArcMap digitální model území. Rozhodla jsem se pro vytvoření 

vektorového datového modelu TIN. TIN charakterizuje povrch nepravidelnou 

trojúhelníkovou sítí. Vzhledem k tomu, že tato data byla ve formátu .xyz, bylo nutné 

nejprve provést konverzi na shapefile dokument. V prostředí ArcGIS je tato funkce 

dostupná takto: ArcToolbox -> 3D Analyst Tools -> Conversion -> From File -> 

ASCII 3D to Feature class. Protože ale vodní hladina při skenování paprsek radaru 

pohltí a neodrazí zpět, síť bodů tedy nepokrývá místa pod vodní hladinou, musela 

jsem tedy pro vytvoření TINu využít ještě vrstevnice pro vodní koryto, které jsem 

získala od Povodí Labe, s.p. Pro tvorbu digitálního modelu terénu byly vyjmuty 

vrstevnice, které se překrývaly s bodovou sítí. Následně byl z bodů a vrstevnic 

vytvořen TIN a to pomocí ArcToolbox -> 3D AnalystTools -> Data Management -> 

TIN -> Create TIN. TIN katastrálního území Křešic je vidět na obrázku č. 10. 

 

  

Obrázek č. 10, TIN katastrálního území Křešic  

Nadmořská výška (m)

317 - 337

297 - 317

277 - 297

257 - 277

237 - 257

217 - 237

197 - 217

177 - 197

157 - 177

137 - 157



 

29 

 

4.3 Práce s extenzí HEC-GeoRAS a softwarem HEC-RAS 

Práce se softwarem HEC-RAS a HEC-GeoRAS se dá rozdělit na tři bloky 

zpracování: 

1) Pre-processing - příprava podkladů ve formě geometrie a příčných profilů toku 

v ArcMap díky extenzi HEC-GeoRAS pro pozdější analýzu v programu HEC-RAS 

2) Processing - Analýza průběhu daných N-letých průtoků vymodelovaným tokem a 

jeho profily v HEC-RAS 

3) Post – processing – vyhodnocení hydraulických výpočtů z HEC-RAS grafickou 

formou za vytvoření rastrů hloubek a rychlostí v prostředí ArcMap 

4.3.1 Pre - processing 

 Prvním krokem v této části bylo vyhotovení geometrie toku. Pro tento účel 

slouží nadstavba HEC-GeoRAS. Před samotnou prací je nutné si nastavit pracovní 

prostředí. Nejprve přes Customize -> Extensions -> musí být zatrhnuto 3D Analyst, 

Network Analyst a Spatial Analyst, V prostředí ArcMap jsem si dále zapnula 

ovládací panel extenze HEC-GeoRAS. V tomto menu jsem si poté nastavila 

strukturu pracovní vrstvy a to přes RAS Geometry -> Layer setup. V daném kroku se 

pod záložkou Required Surface nastavila výchozí datová sada, v mém případě se 

jednalo o vytvořený TIN zájmové oblasti.  

 Jako další krok jsem si vytvořila potřebné RAS vrstvy pro budoucí analýzu 

popisující geometrii toku a to pomocí HEC-GeoRAS -> RAS Geometry -> Create 

RAS Layers . Zhotovila jsem vrstvy XS Cut Lines (příčné řezy), Stream Centerline 

(osa toku), Flow Path Centerline, Bank Lines (břehové linie), které jsem následně 

editovala pomocí editační funkce ArcMap. Takto vytvořené vrstvy se ukládají do 

softwarem automaticky vygenerované geodatabáze a dále je možné je editovat. 

 Nejvhodnější je začít s editací vrstvy Stream Centerline (osa toku). Pomocí 

Editor -> Start Editing -> Stream Centerline -> Edit Tool v prostředí ArcMap jsem 

zdigitalizovala osu toku. Základním pravidlem je digitalizovat tuto osu po směru 

proudění vody, tedy od horní části území po spodní část území. Pro orientaci v terénu 

jsem použila digitální model terénu a ortofoto území. Po skončení editace osy toku 

bylo nutné vytvořené linii přiřadit kód a název. K tomuto účelu slouží tlačítko Assign 

River Code/Reach Code, kdy po vyplnění názvu dojde i k propsání údajů do 

atributové tabulky dané linie. Já jsem linii pojmenovala Labe. V atributové tabulce se 

načetly i další charakteristiky vytvořené linie jako například délka nebo Hydro ID, 

což je unikátní číslo pro každý objekt vytvořený v databázi. Dále pomocí RAS 

Geomoetry -> Stream Centerline Atributes -> All (obrázek č. 11) jsem načetla do 

atributové tabulky i další údaje (topologie, délka, nadmořská výška bodů). Touto 

funkcí byla rovněž vytvořena 3D vrstva osy toku. 

 



 

30 

 

 

Obrázek č. 11, RAS Geomoetry -> Stream Centerline Atributes -> All 

V dalším kroku jsem editovala vrstvu Bank Lines (břehové linie). Břehové 

linie oddělují hlavní vodní tok od oblasti, do které se vylévá voda z koryta při 

vyšších průtocích. Pomocí Editor -> Start Editing -> Banks -> Edit Tool v prostředí 

ArcMap jsem zdigitalizovala  oba břehy. Zásadou je opět dodržovat směr proudění, 

nejprve digitalizovat levý břeh, poté pravý. Jako vodící linii pro vytvoření břehových 

linií jsem použila digitální model terénu a ortofoto. Nakonec jsem využila funkci 

RAS Geometry ->Stream Centerline Attribute-> All. Díky této funkci byla vyplněna 

atributová tabulka vrstvy Stream centerline  

Z vrstvy Stream Centerline vychází částečně vrstva Flow Path Centerline. Proto bylo 

možné vrstvu osu toku vytvořenou v předchozí editaci do této vrstvy pouze 

zkopírovat. Postup by následující: RAS Geometry -> Create RAS Layers -> Flow 

Path Centerlines - > výběr viz obrázek č. 12.  

 

 

Obrázek č. 12, RAS Geometry -> Create RAS Layers -> Flow Path Centerlines 

Pomocí edit tool jsem ve vrstvě Flow Paths následně vytvořila levou i pravou 

linii břehové čáry. Naposledy v této části jsem funkcí Assign Line Type pojmenovala 

a určila Flow Paths.  

Klíčovou vrstvou celé analýzy je vrstva XS Cut Lines. Při vytváření Cut Lines 

(příčných řezů tokem) v editačním režimu v ArcMap je nutné dodržovat několik 

pravidel. Za prvé je pro správný a realitě se nejvíce blížící výsledek potřebné vytvořit 

dostatek příčných profilů. Všechny příčné profily musí být kolmé na osu toku, dále 

musí být zajištěno, aby procházely celým záplavovým územím, a profily je nutné 

vytvářet z leva doprava (Oregon State University, 2013). Vzdálenosti mezi profily 

jsem volila podle místních okolností, průměrná vzdálenost však je 150 m. Šířka 
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příčných profilů vychází ze šířky záplavové oblasti (obrázek č. 13) podle HEIS VÚV 

při největší zaznamenaná povodni. V případě, že došlo ke křížení příčných profilů, 

byly profily po své délce zalomeny.  Naposledy jsem pomocí tlačítka Profile Tool 

zkontrolovala vzhled příčných profilů a ujistila se, že jsou vedeny přes dostatečně 

široké území při případném rozlivu vody z koryta toku. Příčné profily vedené 

územím společně s ukázkovým profilem jsou vyobrazeny na obrázku č. 14.  

 

Obrázek č. 13, Doposud největší přirozený rozliv řeky Labe v obci Křešice, 

http://heis.vuv.cz/data/spusteni/identchk.asp?typ=96&oblast=isvs_zapluz 

 

Obrázek č. 14, Ukázkový příčný profil 

Katastrální hranice 

Příčné řezy

Břehy
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Posléze jsem vytvořila atributy a doplnila výškové poměry pro vrstvu XS Cut 

Lines pomocí RAS Geometry -> XS Cut Line Attributes -> All. Výsledkem této 

činnosti byla identická vrstva s vrstvou XS Cut Lines doplněná výškovými 

charakteristikami.  

 V obci Křešice je vystavěná protipovodňová ochrana na Q20. Tato skutečnost 

musí být rovněž zaznamenaná a zohledněná při výpočtu hydraulického modelu. 

Proto jsem si vytvořila vrstvu RAS Geometry -> Create RAS Layers -> Levee 

Alignment. Vrstvu jsem nadefinovala pomocí editoru. Po vytvoření linií znázorňující 

protipovodňové stěny (obrázek č. 15) jsem pomocí Assign Levee Elevation 

nadefinovala nadmořskou výšku horní hrany stěny pro několik bodů na linii stěny. 

Tato hodnota se pro všechny tři části protipovodňových stěn pohybovala v rozmezí 

150.3-150.5 m n.m. Následně jsem pomocí RAS Geometry -> Levees -> Profile 

Completion vytvořila 3D podobu této prostorové bariéry, která byla později 

zohledněna v hydraulických výpočtech.  

 

 

Obrázek č. 15, Protipovodňová ochrana na území obce – kombinace mobilních stěn a 

trvalých betonových zdí 

 Prostředí HEC-GeoRAS nabízí možnost editovat například i objekty na toku 

jako jsou mosty. V mém případě se na uvažovaném úseku žádné objekty 

nenacházejí, mohla jsem tedy uložit vytvořené vrstvy a ukončit práci s editorem  

v prostředí ArcMap.  

Export geometrie toku z prostředí HEC-GeoRAS 

 Po tom, co byl vytvořen TIN a geometrie toku, lze přejít k exportu 

vytvořených dat pro práci v prostředí HEC-RAS. Před samotným importem bylo 

nutné nastavit, jaké vrstvy budou exportovány. Pomocí RAS Geometry-> Layer 

Setup jsem zkontrolovala nastavení pro Required Layer, kde musí být vybrány vrstvy 

River, XS Cut Lines a XS Cut Lines 3D a Levees. Dále Required Surface, který je 

Katastrální hranice 

Protipovodňová ochrana
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představován vytvořeným TIN a Optional Layers, představující další vrstvy, které je 

možné vyexportovat, ale pouze za podmínky, že tyto vrstvy byly editovány  

a vytvořeny.  

 Posledním krokem v tomto bloku je tedy samotný export dat a to pomocí RAS 

Geometry -> Export RASData. Tento proces vytvořil dva dokumenty GIS2RAS.xml  

a GIS2RAS.RASImport.sdf. 

4.3.2 Processing  

Import geometrických dat do software HEC-RAS 

 Po otevření programu HEC-RAS jsem ze všeho nejdřív uložila nový projekt 

do zvoleného adresáře pomocí File -> Save Project As a to s koncovkou .prj. 

Následně jsem importovala vytvořená data z HEC-GeoRAS a to přes 

 Edit -> Geometric Data -> File -> Import Geometry Data -> GIS Format. 

V otevřeném okně jsem vyhledala soubor s koncovkou .sdf, který byl původně 

vyexportován z HEC-GeoRAS programu. V dalším kroku jsem si nastavila výchozí 

jednotky pro projekt, tedy metrické (soustavy SI) a ostatní okna jsem pouze potvrdla 

bez přenastavování. Posléze byla nahrána geometrická data vyexportovaná 

z programu ArcGIS do okna Geometric Data (obrázek č. 16). V tomto okně je 

možné si prohlížet příčné profily přes tlačítko Cross Section.  

 

 

Obrázek č. 16, Geometrie toku v prostředí HEC-RAS 

V hlavním okně s geometrií toku je také nezbytné vložit informace  

o hydraulické drsnosti prostředí, která ovlivňuje rychlost proudění vody. Ta se 

nastaví v okně pro editaci geometrie přes Tables -> Manning´s n or k values. Profily 

jsou v této tabulce rozděleny na tři části. Sloupec vlevo a vpravo popisuje drsnost 

prostředí mimo koryto toku a prostřední sloupec popisuje drsnost prostředí uvnitř 
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koryta toku. Pro místa mimo koryto toku, která procházejí zastavěným územím nebo 

lesním porostem jsem nastavila hodnotu 0.1, zemědělskou půdou 0.04 a pro samotné 

koryto hodnotu 0.03. Nastavení drsností je patrné z obrázku č. 17. Geometrii toku 

jsem si uložila přes File -> Save Geometry Data. Velmi výhodné je zkontrolovat 

profily pomocí funkce v grafickém editoru Tools - >Graphical Cros -section Edit. 

Hodnoty drsností pro koryto toku a různé povrchy záplavového území jsou uvedeny 

v tabulce č. 3 a 4.  

 

Hlavní koryto toku       

Nezanesené, přímé, bez prohlubní 0.03 

Nezanesené, přímé, bez prohlubní, drobné kameny 0.035 

Nezanesené, vinuté, drobné nánosy 0.04 

Mírně zanesené, větší kameny 0.045 

Tabulka č.  3, Hodnoty drsností pro koryto toku (Brunner, 2010b) 

Záplavová území       

a, Pastviny       

Nízký porost 0.03 

Vyšší porost 0.035-0.04 

b, Kultivované plochy     

Po sklizni 0.03 

Vzrostlá vegetace 0.035-0.04 

c, Porosty s keři, stromy     

Roztroušené keře, vysoká tráva 0.04-0.05 

Vyšší keře a stromy ve vegetačním období 0.04-0.06 

Vysoké stromy a keře ve vegetačním období 0.1 

d, Urbanizované plochy     

Všeobecně 0.1 

Tabulka č.  4, Hodnoty drsností pro záplavová území (Brunner, 2010b) 
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Obrázek č. 17, Hodnoty drsnostního součinitele podle Manninga 

Nastavení podmínek proudění a okrajových podmínek  

 Aby mohl být proveden výpočet pro jednotlivé N-leté průtoky, které 

potenciálně způsobí zaplavení území, bylo nutno kulminační průtoky N-letých 

průtoků zadat do programu HEC-RAS. Pomocí Edit -> Steady Flow Data pod 

záložkou Enter/Edit Number of Profiles jsem specifikovala počet scénářů – v mém 

případě to byly 4 (Q20, Q50, Q100 a Q500). V tom samém okně jsem pod Options -> 

Edit Profile Names změnila názvy pro jednotlivé uvažované průtoky. Po nahrání 

daných nastavení jsem zadala hodnoty N-letých průtoků pro jednotlivé scénáře dle 

tabulky č. 2.  

Rovněž zadání okrajových podmínek pro analýzu dat je velmi důležité. Na 

místě bylo zadat okrajové podmínky pro počátek i konec úpravy řešeného části Labe. 

Pro úsek byly nastaveny okrajové podmínky pomocí Edit -> Steady Flow Data -> 

Reach Boundary Conditions. Okrajová podmínka pro spodní část řešené části toku 

byla nastavena jako Normal Depth. Při použití této podmínky se předpokládá, že zde 

není přítomen žádný vodní skok. Hodnota, která se uvádí při aplikaci této podmínky, 

je hodnota sklonu pod řešenou částí toku. Pro získání této hodnoty jsem vycházela 

z hodnoty sklonu řešeného úseku a tento údaj jsem následně optimalizovala tak, aby 

byl průběh hladiny v koncových profilech plynulý.  

Protipovodňová stěna, levees 

 V případě, že se v blízkosti vodního toku, respektive na jeho břehu, nachází 

protipovodňová stěna či jiná vertikální bariéra, je užitečné tuto skutečnost 

v profilech, ve kterých se tato bariéra nachází, zaznamenat. V mém případě jsem 
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výšku protipovodňových stěn specifikovala již v prostředí HEC-GeoRAS. Stejný 

postup se ale provádí i v případech, že koryto má v příčném profilu různé terénní 

prohlubeniny oddělené vertikální stěnou nebo valem. Program HEC-RAS neumí 

vyhodnotit, zdali má nejprve plnit vodou hlavní koryto a poté až tyto prohlubeniny 

za bariérou a plní tedy koryto i terénní prohlubeniny konstantně odspoda a proto se 

pro určení plnění využívá funkce Edit -> Geometric Data -> Cross Sections -> 

Options -> Levees, kde se nastaví výška, při které se zajistí, že se místo za bariérou 

začne plnit až po dosáhnutí nejvyššího bodu bariéry proudící vodou v korytě. Rozdíl 

po nastavení této charakteristiky je patrný z obrázku č. 18.   

 

  

Modré linie znázorňující výšku hladiny při 

Q5, Q20, Q100 a Q500 bez použití funkce levees 

 

 Modré linie znázorňující výšku hladiny při 

Q5, Q20, Q100 a Q500 s použitím funkce levees 

 

Obrázek č. 18, Využití funkce levees 

Redukce počtu bodů příčných profilů 

 Každý profil v prostředí HEC-RAS může být sestaven až z 500 bodů. Pokud 

by model obsahoval profil s více než 500 body, nedojde k závěrečnému výpočtu. 

Proto jsem přes Edit -> Geometric Data -> Tools -> Cross Section 

Points Filter provedla redukci počtu bodů. V otevřeném okně jsem si zvolila záložku 

Multiple Locations a vybrala jsem pro redukci pomocí tlačítka se symbolem šipky 

všechny profily. Poté na záložce Minimize Area Change jsem nastavila snížení počtu 

bodů v profilech na 400.  

Výpočet modelu v HEC-RAS 

 Ve chvíli, kdy byly vypracované vstupní parametry hydraulického modelu, 

bylo možné spustit výpočet zamýšleného modelu. Jelikož v uvažovaném případě 

předpokládám říční ustálené nerovnoměrné proudění, využila jsem analýzu Steady 

Flow. Ještě před samotným spuštěním výpočtu jsem si nastavila počet úseků 

vertikálního členění jednotlivých profilů pro odvození rychlostí. Protože program 

HEC-GeoRAS, ve kterém dochází k pozdějšímu vytvoření rastru rychlostí, pouze 
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interpoluje hodnoty rychlostí z bodů jednotlivých profilů, je užitečné vytvořit vysoké 

množství bodů, ze kterých je brána hodnota pro interpolaci. Pro tento účel jsem 

v hlavním okně HEC-RAS postupovala takto: Run -> Options -> Flow Distribution 

Locations -> Set Specific Location Subsection Distribution -> Number of 

SubSections nastavila pro levou, pravou i centrální část každého z příčných profilů 

nastavila hodnotu 15. Následně jsem toto potvrdila tlačítkem Set Selected Range. 

Naposledy jsem tedy spustila model přes hlavní okno aplikace HEC-RAS -> Run -> 

Steady Flow Analysis.  

Výsledky hydraulického modelování 

 Po dokončení výpočtu v prostředí HEC-RAS je účelné se podívat na grafické 

výsledky modelu. Jako první jsem zkontrolovala průběh hladiny toku při daných 

průtocích. Průběh hladiny se zdá z podélného profilu být v pořádku, jelikož zde 

nedochází na konci řešené části ke vniku kritického proudění vlivem prudkého 

snížení výšky nebo vzdutí hladiny vody – tedy ke změně režimu proudění z říčního 

na bystřinné, a to díky správně zvoleného hodnotě sklonu při nastavování okrajových 

podmínek. Rozdíl je patrný z obrázku č. 19. Pro snížení vlivu chyby dolní okrajové 

podmínky je zvolen počáteční profil úseku 250 m pod zájmovým územím.   

 

  

Podélný profil korytem s naznačenými 

průběhy hladin pro N-leté průtoky 

 

  Podélný sklon s velmi nevhodně 

zvoleným sklonem – vznik vodního skoku 

 

Obrázek č. 19, Volba podélného sklonu 

Účelné je rovněž vizuálně zkontrolovat příčné profily, zdali je jejich šířka 

dostatečná pro rozliv vody i při velmi vysokých objemech. V příčném profilu je dále 

možné si zobrazit vertikální rozdělení rychlostí proudící vody, což je výhodou 1,5D 

modelování, které je využívané pomocí software HEC-RAS. Obrázek č. 20 

vyobrazuje vertikální členění rychlosti vody v profilu.  
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Obrázek č. 20, Příčný profil toku se znázorněnými rychlostmi vody pro Q5 

Export hydrodynamického modelu 

 Pokud nenastal během vytváření a výpočtu modelu žádný problém  

a nezobrazilo se varovné okno, je možné přistoupit k exportu dat z modelu a k jejich 

vizualizaci v programu ArcMap. Pro export modelu je zapotřebí v hlavním okně 

programu HEC-RAS jít na File -> Export GIS Data (viz obrázek č. 21). Modely pro 

scénáře řešených N-letých průtoků je potřebné vybrat pomocí tlačítka Select Profiles 

to Export. Současně jsem si vygenerovala i mapu rychlostí po zatrhnutí položky 

Velocity. V této fázi je rovněž možné zvolit, zdali mají být výsledky vygenerovány 

pro každý povodňový scénář nebo pro jednotlivé zvolené scénáře. V mém případě 

jsem nechala model vyexportovat data pro všechny čtyři povodňové scénáře. Po 

nastavení požadovaných podmínek jsem export dat potvrdila tlačítkem Export Data. 

Tento krok vytvoří výstupní dokument prostředí HEC-RAS s koncovkou .sdf.  

 

Obrázek č. 21, Nastavení pro export dat z prostředí HEC-RAS 
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4.3.3 Post - processing 

Prezentace výsledků hydrodynamického modelu v prostředí ArcGIS 

 Prezentaci výsledků předchází import dat do platformy ArcGIS. 

V dokumentu ArcMap je toto možné pomocí tlačítka Import RAS SDF pod 

ovládacím panelem extenze HEC-GeoRAS. Operace spuštěné tímto tlačítkem 

převádí vyexportovaný soubor SDF do struktury XML. V konvertovacím okně, které 

toto tlačítko vyvolá, jsem zadala vstupní data pro transformaci ve formátu SDF  

a umístění budoucího transformovaného dokumentu.  

Nastavení pracovního prostředí 

 Pro práci s výsledky datového souboru XML bylo nutné nastavit vstupní 

parametry pro vizualizaci vrstev. Přes RAS Mapping -> Layer Setup (obrázek č. 22) 

byla na kartě  Analysis Type -> New Analys pojmenována nová analýza. Poté jsem 

nastavila cestu k vyexportovaným datům z programu HEC-RAS (RAS GIS Export 

File). V neposlední řadě jsem vybrala digitální model terénu (DTM) ve formě již 

vytvořeného TIN. Posledním postupem bylo nastavení adresáře pro uložení analýzy. 

Při definování každé nové analýzy je vyvoláno vložení nového data frame do 

prostředí ArcMap a zároveň je vytvořena nová geodatabáze pro ukládání 

vygenerovaných vrstev, která je defaultně pojmenována jako RASResults. Veškeré 

další procesy při grafickém zpracování výsledků vycházejí z digitálního modelu 

území – tedy TIN vrstvy a z výstupního souboru vypracovaného v prostředí HEC-

RAS –SDF nebo XML dokumentu (US Army Corps of Engineers, 2009).  

 

 

Obrázek č. 22, Nastavení pracovního prostředí pro vizualizaci výsledků modelu 

Import podkladových vrstev 

 Po předchozím nastavení pracovního prostředí jsem importovala RAS data 

(konvertovaný SDF dokument) a to přes extenzi HEC-GeoRAS:  Mapping -> Import 

RAS data. Takto byl vložen polygon určující rozsah rozlivu – Bounding Polygon  
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a spolu s ním byly také znovu vygenerovány samotné příčné řezy tokem. Tyto dvě 

vrstvy jsou vkládány do analýzy v prostředí ArcMap defaultně, protože z nich 

vychází pozdější analýza v území. 

Posléze jsem využila funkce RAS Mapping -> Inundation Mapping. Nejprve 

jsem vygenerovala pomocí Water Surface Generation vrstvu, která představuje 

nadmořskou výšku terénu v každém uvažovaném příčném profilu toku v rozmezí 

příčných profilů toku (obrázek č. 23). V tomto kroku je možné zvolit, zdali má 

program vytvořit tuto TIN vrstvu pro každý specifikovaný scénář průtoků nebo 

pouze například pro jediný scénář.  

 

Obrázek č. 23, Výškové poměry jednotlivých profilů 

Mapy hloubek, rychlostí a rozsah rozlivů 

 Hloubky a rychlosti vody v řešeném území popisují rastry hloubek  

a rychlostí. HEC-RAS počítá rychlosti proudící vody v bodech každého řešeného 

příčného profilu vodního toku a mezi za sebou jdoucími profily tedy dochází 

k interpolaci bodových hodnot. V místech, kde je stanovena hloubka vody jako nula, 

je i rychlost vody nulová. Obecně tato interpolace rychlostí vody mezi profily 

podává kvalitní výsledky, pokud jsou profily v přiměřené vzdálenosti od sebe dle 

vlastností toku (Evans & kol., 1999).  

 Mapy hloubek byly vytvořeny po importu hodnot modelu z HEC-RAS do 

prostředí HEC-GeoRAS na základě digitálního modelu terénu TIN pomocí RAS 

Mapping -> Inundation Mapping -> Floodplain Delineation Using Rasters, kde bylo 

opět možné zvolit, pro který ze scénářů průtoků se má vrstva vytvořit. Poté tedy 

došlo k vytvoření rastru hloubek vody v potenciálně zaplaveném území pro 

jednotlivé scénáře průtoků. Výsledné hloubky vody v řešeném geografickém území 

závisí na hloubce vody při jednotlivých N-letých průtocích v průniku s výškovým 

průběhem povrchu oblasti stanovené z digitálního modelu terénu TIN. Obrázek č. 24 

zobrazuje hloubky vody pro Q100 a Q500.  
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Rastr hloubek vody pro Q100    Rastr hloubek vody pro Q500 

Obrázek č. 24, Rastry hloubek vody pro Q100 a Q500  

 Mapy rychlostí byly získány pomocí RAS Mapping -> Velocity Mapping. 

Tento postup opět vyvolá dialogové okno, ve kterém je možné zvolit, pro který 

povodňový scénář mají být mapy rychlostí vytvořeny. Výsledný rastr rychlostí byl 

přidán do Data Frame. Tento rastr popisuje rychlosti proudění vody v m/s. 

Rozložení rychlostí pro Q100 a Q500 je vidět na obrázku č. 25.  

    

Rastr rychlostí vody pro Q100        Rastr rychlostí vody pro Q500  

Obrázek č. 25, Rastry rychlostí vody pro Q100 a Q500 
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4.4 Vyjádření povodňového rizika – semikvantitativní přístup 

4.4.1 Stanovení zranitelnosti území, plán funkčních ploch obce 

Jedním z podkladů pro tvorbu map povodňových nebezpečí a rizik je 

vyjádření zranitelnosti území, které vychází z územního plánu. Vzhledem k tomu, že 

obec Křešice nemá vyhotovený digitální územní plán, bylo tedy nejprve nutné 

vytvořit mapu funkčního využití ploch v území pomocí softwaru ArcMap. Od ČUZK 

jsem zdarma získala potřebné podklady, podle kterých bylo možné určit různé druhy 

funkčních ploch sledovaného území. Mezi tyto podklady patří základní mapa 1:5 000 

(ZABAGED), letecké snímky (ortofota) sloužící jako zdroje informací o aktuálním 

stavu řešeného území, tedy pro určení různých druhů povrchů a rozložení vegetace. 

Dále byly přínosné i katastrální mapy. Pro informaci o využívání území jsem také 

využila internetové stránky obce a provedla terénní průzkum. 

V programu ArcMap jsem v editačním režimu z uvedených podkladů 

provedla vektorizaci objektů a funkčních ploch potřebných pro výsledky této 

diplomové práce. Pro účely stanovení zranitelnosti území a s ohledem na postup 

uvedený v Metodice tvorby map povodňového nebezpečí a povodňových rizik 

vydanou VÚV T.G. Masaryka v Praze roku 2009 (dále jen v Metodice VÚV), byly 

funkční plochy v území klasifikovány do těchto kategorií – plochy bydlení, občanské 

vybavenosti, technické vybavenosti, dopravy, výrobních ploch a skladů, rekreace  

a sportu a zahrad. Pro potřeby rizikové analýzy bylo nutné dále vyobrazit citlivé 

objekty, ve kterých je běžná vyšší koncentrace lidí (školy, nemocnice, ústavy 

sociální péče) a velmi důležité objekty, které zajišťují fungování obce (objekty 

energetiky, tlakové stanice plynu, úpravny pitných vod a podobně). 

 Do kategorie bydlení všeobecně spadají domy, bytové domy, budovy pro 

přechodné bydlení.   

Do kategorie občanské vybavenosti patří na území Křešic místní mateřská  

a základní škola, ordinace praktického lékaře, kostel Nejsvětější Trojice, Panny 

Marie a sv. Matouše, hřbitov, knihovna, památný strom, obecní úřad, policie, pošta, 

restaurace, sbor dobrovolných hasičů (v katastru disponují dva sbory). 

 Technickou vybavenost v Křešicích představují objekt solární elektrárny, 

čistírna odpadních vod, skládka, odkaliště, veřejný vodovod, plynovod a vedení 

elektrického napětí. 

 Mezi objekty dopravní infrastruktury v Křešicích patří železniční stanice, 

železnice a pozemní komunikace. 

 Prostor pro sport a rekreaci slouží v Křešicích hřiště a zahrádkářské kolonie.  

 Převážná část katastrálního území Křešic je tvořena výrobními plochami  

a sklady. Do těchto ploch spadá orná půda, chmelnice, fabrika, skladovací plochy, 

skleníky a ostatní výrobní plochy.  
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 Zbytek území vyplňují plochy zeleně a zahrad – lesní půda se stromy nebo 

křovinatým porostem, okrasné zahrady, parky, ovocné sady a trvalé travní porosty.  

 Do kategorie citlivých objektů jsem zahrnula kulturní památky obce, budovu 

školy, hasičskou zbrojnici, policejní stanici, ordinaci lékaře a ČOV.  

 Dle Metodiky VÚV se do mapy rizik zahrnují i plochy návrhové  

a výhledové. Na základě poskytnutých podkladů od obce jsem zjistila, že prozatím 

jsou jako návrhové plochy určeny pouze plochy pro bydlení.  

 Kategorie charakterizující zranitelnost území jsou patrné z obrázku č. 26.  

 

 

Obrázek č. 26, Kategorie charakterizující zranitelnost území obce Křešice 

4.4.2 Kvantifikace povodňového nebezpečí  

 Povodňové nebezpečí je určováno pomocí několika charakteristik. Mezi ně 

patří rozsah rozlivu, hloubka a rychlost vody v záplavové oblasti. O exportu  

a vizualizaci rastrů, které nesou informace o rozsahu rozlivu, hloubkách  

a rychlostech vody pro zkoumané území, bylo zmíněno v předchozí kapitole (Mapy 

hloubek, rychlostí a rozsahu rozlivů). Dané charakteristiky se poté zpracovávají do 

hodnot intenzity povodně (Jelínková, 2013).  
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Intenzita povodně IP je chápána jako měřítko ničivosti povodně a je 

definována jako funkce hloubky vody h [m] a rychlosti vody v [m/s] (Beffa,  2000, 

Drbal & kol., 2005, Říha & kol., 2005). Pro stanovení intenzity povodně je možné 

v nástrojích software GIS aplikovat pro výpočet vztah, takzvanou matici rizika, 

kterou uvádí ve své Metodice VÚV Drbal & kol. 2009:  

IP =    {
      

                       

                    
} 

kde vstupními údaji pro výpočet intenzity povodně IP jsou rastrové vrstvy hloubek  

a rychlostí vody, které byly získány při post-processingu v HEC-GeoRAS. Proměnná 

h je tedy představována hodnotami hloubek z rastrové vrstvy hloubek a proměnná 

v  je představována hodnotami rychlostí rastrové vrstvy rychlostí. Implementace této 

matice do prostředí GIS byla provedena díky nástroji Raster Calculator a jeho funkci 

Con. Tento nástroj je velice užitečný pro výpočet nových hodnot buněk rastru na 

základě vložení daného vztahu. Díky funkci Con je možné využít zadávání vztahů ve 

formě podmínek při současné numerické analýze více vrstev za získání nové vrstvy 

s přepočítanými hodnotami dle vstupního vztahu. 

Aplikace této matice pro výpočet intenzity povodně IP byla nutná pro každý 

povodňový scénář. Pro každý povodňový scénář by mělo mít použití této matice tři 

výstupní vrstvy, každá pro vyjádření jednotlivých řádků matice. 

Pro první řádek matice, v mém případě hodnoty hloubek h, v žádné 

z vyexportovaných rastrových vrstev nedosahovaly hodnoty nula, ale hodnota h byla 

vždy větší než nula, tudíž jsem tuto část matice mohla vynechat z přepočítávání. 

Intenzita povodně IP = 0 je tedy všude tam, kde se voda nerozlévá, tedy tam, kde je 

výška hladiny rovna nule.  

Druhý řádek matice formuluje vzorec, který se využívá v případě, že hodnoty 

buněk rastru hloubek mají hodnotu větší než nula a současně hodnoty buněk rastru 

rychlostí dosahují hodnoty menší než jedna. Pokud nastane takováto situace, hodnoty 

buněk obou zmiňovaných rastrů je nutné přepočítat tak, že hodnota hloubky h se 

násobí koeficientem 1.35 a k výsledku se přičte konstanta 0.3. Na místo buněk rastrů, 

v nichž je dosaženo podmínky dané h > 0 a současně v < 1, je vytvořena nová 

rastrová vrstva s hodnotami danými zmíněným výpočtem. Tento výpočet se provede 

příkazem ArcToolbox -> Spatial Analyst Tools -> Map Algebra -> Raster 

Calculator 

Formulace vzorce do Raster Calculator pro tento případ: 

Con(((“hloubky_QN“>0) & (“rychosti_QN“<1)), (0.3+(1.35*(“hloubky_QN“)))) 

 

Dialogové okno se zadaným vztahem pro výpočet pomocí Raster Calculatoru 

je na obrázku č. 27.  
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Obrázek č.  27, Příklad použití Raster Calculatoru 

Obdobný postup platí i pro třetí řádek matice. Tento řádek matice formuluje 

vzorec, který se využívá v případě, že hodnoty buněk rastru rychlostí dosahují 

hodnoty větší než jedna. Pokud nastane tato situace, hodnoty buněk rastrů 

popisujících hloubky a rychlosti proudění vody je nutné přepočítat tak, že se hodnota 

buňky rastrové vrstvy hloubek h násobí hodnotou buňky rastrové vrstvy rychlostí v. 

Tato hodnota se dále násobí koeficientem 1.35 a k výsledku se přičte konstanta 0.3. 

Na místo buněk rastrů, v nichž je dosaženo podmínky v > 1, je vytvořena nová vrstva 

s hodnotami danými zmíněným výpočtem.  

Formulace vzorce do Raster Calculator pro tento případ: 

Con(((“rychlosti_QN“)> 1), (0.3 + (1.35* (“hloubky_QN“)*(“rychlosti_QN“)))) 

 

Tímto postupem byly vytvořeny dvě nové rastrové vrstvy pro každý 

povodňový scénář, které hodnotami svých buněk popisují hodnoty intenzity povodně 

IP. Obě vrstvy na sebe kontinuálně navazují. Tyto vrstvy jsou vidět na obrázku č. 28. 

Prostorový rámec rastrové vrstvy intenzity povodně IP zobrazuje i rozsah 

rozlivu vody v území. 

Vzhledem k tomu, že obec má vystavěnou protipovodňovou stěnu, byly 

výpočty provedeny pro jednotlivé scénáře Q5, Q20, Q100 a Q500 pro situaci 

s protipovodňovou ochranou a bez ní.   
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Intenzita povodně IP pro Q100 při h>0 m a 

v<1 m/s 

Intenzita povodně IP pro Q100 při h>0 m a 

v<1 m/s 

Obrázek č. 28, Intenzita povodně zobrazená pomocí rastrů 

Za použití nástroje Cell Statistic byly vytvořené vrstvy intenzity povodně pro 

jednotlivé scénáře sjednoceny do jedné vrstvy (obrázek č. 29), se kterou bylo možné 

provádět další analýzu.  

 

  

Obrázek č. 29, Výsledná intenzita povodně IP pro Q100 

4.4.3 Stanovení povodňového ohrožení 

Ohrožení Hi(x,y) při daném povodňovém scénáři Qi(Pi) je v určitém místě (se 

souřadnicemi x, y) řešeného území vyjádřeno jako funkce pravděpodobnosti Pi 
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výskytu daného povodňového scénáře (při stanovené N-letosti kulminačního 

průtoku) a intenzity povodně IPi(x,y) (Beffa, 2000): 

 

Hi(x,y) = IPi(x,y) . Pi 

kde 

Pi = 1 – e
(-1/N)

, resp. Pi = 1/N pro velká N (cca N > 10) 

N je doba opakování povodňové událost v rocích. 

 

Rovněž tento výpočet byl proveden pomocí Raster Calculator: ArcToolbox  

-> Spatial Analyst Tools -> Map Algebra -> Raster Calculator (obrázek č. 

30Obrázek č. 30), kde se jednotlivé rastry popisující intenzitu povodně IP přenásobí 

koeficientem Pi dle řešeného povodňového scénáře. 

 

 

Obrázek č. 30, Příklad použití Raster Calculatoru 

Výsledné hodnoty rastrové vrstvy ohrožení H pro jednotlivé N-leté 

povodňové scénáře byly následně díky funkci Reclassify: ArcToolbox -> Spatial 

Analyst Tools -> Reclass -> Reclassify;  reklasifikovány do intervalů charakterizující 

míru ohrožení dle tabulky č. 5.  
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Tabulka č. 5, Hodnoty specifikující intervaly, které popisují míru ohrožení (Drbal & kol., 

2009) 

Kategorizace celkového ohrožení území vychází z nejvyšší dosažené hodnoty 

ohrožení v daném místě, viz obrázek č. 31. Tato hodnota se získá průnikem 

informací o ohrožení každého N-letého průtoku. Nejvyšší hodnoty ohrožení se 

vyskytují samozřejmě v korytech a v místech, kde dochází k rozlivu vody z koryta 

toku a při povodních s vysokou pravděpodobností opakování (Q5).  

Protože byl výpočet hodnot povodňového ohrožení proveden pro každý 

povodňový scénář zvlášť, bylo poté nutné pro vybrání maximální hodnoty v každé 

buňce rastru reprezentující jednotlivý povodňový scénář využít nástroj Cell Statistics 

a funkci Maximum: ArcToolbox ->Spatial Analyst Tools -> Local -> Cell Statistics. 

Výsledné intervaly hodnot ohrožení se zobrazují pomocí barevné škály odpovídající 

tabulce č. 5. Výsledkem je mapa zobrazující míru ohroženosti ploch a na jejím 

základě je možné stanovit budoucí ploch v obci (obrázek č. 32). 

 

 

Obrázek č. 31, Výběr maximální hodnoty ohrožení, (Jelínková, 2013) 
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Obrázek č. 32, Povodňové ohrožení obce Křešice 

4.4.4 Stanovení povodňového rizika 

 Povodňové riziko je určeno průnikem informací o povodňovém ohrožení  

a zranitelnosti řešeného území. Každá kategorie funkčních ploch má stanovenou 

míru přijatelného rizika dle tabulky č. 1. a v mapách povodňového rizika jsou pak 

zobrazeny plochy daných kategorií, u kterých došlo k překročení přijatelného rizika 

(Drbal & kol., 2009). Hodnoty ohrožení pro každou z ploch, ve které došlo 

k překročení přijatelnosti, jsou uvedeny pomocí barevné škály opět dle tabulky č. 1.  

 Vyhodnocení povodňového rizika pro funkční plochy, u kterých je stanovena 

maximální hodnota přijatelného nebezpečí dle tabulky č. 1, jsem provedla pomocí 

nástroje: ArcTool Box -> Data Management Tools -> Raster -> Raster Processing -

> Clip, čímž jsem vytvořila průnik informací rastrové vrstvy povodňového ohrožení 

s polygonovou vrstvou funkčních ploch. Jelikož u vrstvy Lesů a zeleně je přijatelné 

riziko stanoveno jako vysoké, což je nejvyšší klasifikované ohrožení, bylo možné 

tyto plochy z budoucího klipu vyloučit. U všech zbylých funkčních ploch, do kterých 

zasahovaly buňky rastrové vrstvy udávající ohrožení, byla překročena míra 

přijatelného rizika, a proto nebylo potřebné z výsledného clipu rastru ohrožení 

extrahovat další buňky. Průnik informací o povodňovém ohrožení a kategorií 

funkčních ploch, tedy mapa rizika, je patrný z obrázku č. 33.  

 

Ohrožení

Reziduální

Nízké

Střední

Vysoké

Katastrální hranice
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Obrázek č. 33, Mapa rizika pro obec Křešice 

 

4.5 Vyjádření povodňového rizika – kvantitativní přístup 

 Povodňové riziko lze vyjádřit i ve výši finančních škod na objektech. Určení 

těchto ztrát se liší dle typů objektů, které byly záplavou poškozeny. Ceny daných 

objektů a jejich vybavení vychází z pořizovacích cen jednotlivých posuzovaných 

kategorií, které jsou odvozeny z cenových ukazatelů ve stavebnictví. Dále výpočet 

vychází z rozboru výšky zaplavení vybraných staveb v závislosti na ztrátové křivce, 

která udává minimální a maximální hodnotu výše škody pro vybranou kategorii 

staveb. Hloubka zaplavení není zohledňována například při výpočtu ztrát na 

dopravní infrastruktuře (Drbal & kol., 2009).V této diplomové práci byly pro 

jednotlivé kategorie uvažovány hodnoty minimálních škod, ke kterým může při 

povodňové události dojít. Do skupin objektů, pro které je dle Metodiky VÚV 

stanovována výše škod, v obci Křešice patří tyto kategorie: stavební objekty, 

vybavenost bytů a občanská vybavenost, sportovní plochy, pozemní komunikace, 

inženýrské sítě a průmysl. Jako podklad pro určení rozlohy a umístění uvedených 

kategorií jsem využila polygonové vrstvy z dříve vypracovaného digitálního plánu 

funkčních ploch pro obec Křešice.  
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 Pro účely této diplomové práce jsem brala v úvahu účinnost protipovodňové 

ochrany obce, a proto jsem zjišťovala průměrnou výši škod pouze pro povodňový 

scénář, který by nastal při Q100 a Q500.  

Škody na stavebních objektech 

Škody na stavebních objektech se počítají dle vzorce pro výpočet ztrát na 

stavebních objektech DSO:  

 

DSO = A.L1(h).C1, [Kč] 

kde 

DSO je ztráta na stavebních objektech 

A je plocha polygonu budovy [m
2
] 

L1(h) je hodnota ztráty vyjádřená ze ztrátové funkce pro danou hloubku záplavy 

kolem objektu 

C1 je jednotková cena jednoho podlaží budovy [Kč/m
2
], (Drbal & kol., 2009). 

 

Ke stanovení výše škody na stavebních objektech jsem si nejprve 

kategorizovala rastr hloubek vody do intervalů po 1 metru, jelikož hodnota ztráty na 

stavebním objektu dle Metodiky VÚV vychází z intervalů  o velikosti 1 m. Z rastru 

hloubek pro Q100 a Q500 jsem si intervaly vytvořila v prostředí ArcMap pomocí 

funkce ArcTool Box -> Spatial Analyst Tools -> Reclass -> Reclassify. Abych 

snížila časovou náročnost těchto kroků, využila jsem Model Builder (obrázek č. 34). 

 

 

Obrázek č. 34, Vztah pro reklasifikaci rastrů v prostředí Model Builder 
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Reklasifikace hloubek pro Q100   Reklasifikace hloubek pro Q500 

Obrázek č. 35, Reklasifikované hloubky vody do intervalů po 1 m 

Pro zjištění výšky záplavy u jednotlivých stavebních objektů jsem 

vyexportovala hodnoty rastrové vrstvy hloubek body, které představují síť rozložení 

hloubek v záplavové oblasti. K této operaci jsem opět využila Model Builder 

(obrázek č. 36). 

 

 

Obrázek č. 36, Vytvoření bodové sítě z rastrů 

Následně jsem provedla průnik této bodové vrstvy s vrstvou bydlení, která 

obsahuje polygony, jež vymezují jednotlivé domy v obci. Tato analýza, která přidá 

do atributové tabulky polygonové vrstvy Bydlení každému objektu průměrnou 

hodnotu jeho zaplavení, se jmenuje Spatial Join. Analýza proběhla na základě 

průniku bodů s danými hodnotami hloubek a jednotlivými objekty pomocí 

matematické operace Mean – tedy průměrné hodnoty z bodů spadajících pod daný 

stavební objekt. Tímto jsem tedy získala informace o tom, který dům je zaplaven do 

jaké výšky. Hodnota zaplavení jednotlivého polygonu, tedy stavebního objektu, byla 

propsána díky funkci Spatial Join (obrázek č. 37) do atributové tabulky vrstvy 

Bydlení.  
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Obrázek č. 37, Funkce Spatial Join 

Dále jsem pomocí funkce Calculate Geometry -> Area v atributové tabulce 

vrstvy představující jednotlivé domy spočítala plochu domů, jelikož je tato 

informace potřebná pro stanovení výše škod.  

Dalším krokem byla implementace vztahu pro výpočet ztráty na stavebních 

objektech. V atributové tabulce vrstvy bydlení jsem do nového sloupce pro každý 

interval výšky záplavy, který jsem si vybrala pomocí SQL dotazů, vypočítala pomocí 

Field Calculatoru hodnotu ztráty na stavebních objektech DSO. Veličina A je tedy 

určena plochou objektu, za veličinu L1 jsem volila minimální hodnotu ztráty L dle 

tabulky č. 6 a hodnotu C1, která představuje cenu budovy na m
2
,
 
jsem dle Metodiky 

VÚV nastavila na 15 416 Kč. 

 

Ztráta % 
Hloubka zaplavení (m) 

0 1 2 3 4 5 6 7 8 9 10 

Lmin 2,23 6,69 9,93 12,69 17,15 20,38 23,15 27,61 30,84 33,61 38,07 

Lmax 3,55 10,64 16,50 21,89 28,98 34,84 40,23 47,32 53,18 58,57 65,66 

Tabulka č.  6, Procentuální vyjádření minimální a maximální ztráty (L) na stavebních 

objektech v závislosti na hloubce zaplavení (Drbal & kol., 2009 ex. Horský, 2008)  

Vzorec pro výpočet výše ztrát na stavebních objektech v aplikaci Field 

Calculator například pro hloubku vody 4m byl vytvořen následovně (obrázek č. 38): 
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Obrázek č. 38, Použití Field Calculatoru pro výpočet ztrát 

Po sečtení ztrát na všech zasažených objektech pro Q100 činí ztráta  

136 210 945 Kč, pro Q500 138 695 387 Kč. Výše škod na stavebních objektech 

zahrnuje i stavební objekty v zahrádkářských koloniích na území obce. 

Škody na vybavenosti bytů a občanské vybavenosti 

Škody na vybavenosti bytů a občanské vybavenosti se stanovují až od výšky 

zaplavení 0.5m. Pro výpočet těchto ztrát se obdobně jako v předchozím kroku 

pomocí funkce Field Calculator aplikoval následující vzorec: 

 

DV = A.ZV,  [Kč] 

kde 

A je plocha zasažených bytových objektů a občanské vybavenosti s hloubkou 

zaplavení hmin = 0,5 m a více [m
2
],  

ZV je ztrátová cena [Kč/m
2
],  která je jako minimální hodnota dle Metodiky VÚV 

stanovena na 1143 Kč/m
2 
(Drbal & kol., 2009). 

 

Celková škoda na vybavenosti domácností pro Q100 by dosáhla  

69 499 882 Kč a na občanské vybavenosti 4 559 088 Kč, celkem tedy  

74 058 970 Kč. Pro Q500 69 854 201 Kč + 4 559 088 Kč, celkem 74 413 289 Kč. 

Sumy vyšly podobně, jelikož při stanovení výše ztráty na vybavenosti se nebere 

v úvahu hloubka záplavy, ale pouze její rozsah a Q500 má oproti Q100 rozsah nepatrně 

větší.  

Škody na sportovních plochách 

V obci se nachází hřiště, které je dle Metodiky VÚV zahrnuto do kategorie 

sportovních ploch. Výše ztráty vychází z průměrné pořizovací ceny jednotlivých 

objektů při současném určení míry poškození. Při předpokládané minimální míře 
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poškození trávníkového povrchu ztráta činí 91 Kč/m
2 

(Drbal & kol., 2009). Rozloha 

hřiště tvoří 1 842 m
2
 a výše škody pro Q100  i Q500 by dosáhla 167 622 Kč.  

Škody na pozemních komunikacích  

V případě, že byly záplavami zasaženy i pozemní komunikace nebo 

železnice, vychází výše ztrát z ceníků JKSO. Dle Metodiky VÚV byla minimální 

ztrátová cena pro silnice stanovena na 60 Kč/m
2
 a pro železnice na 429 Kč/ m

2
. 

Vztah pro výpočet ztráty je následující: 

 

DPK = A. ZK, [Kč] 

kde 

A plocha objektu [m
2
] 

ZK1 ztrátová cena [Kč/m
2
], (Drbal & kol., 2009). 

 

Při povodňové události by byly zasaženy pozemní komunikace o rozloze 

32 079 m
2
 a železnice o rozloze 19 058 m

2
. Celková potenciální škoda by tedy činila 

10 100 622 Kč a je shodná pro Q100 i Q500, jelikož by k zaplavení došlo při obou 

povodňových scénářích a vztah nezohledňuje výšku zaplavení.  

Škody v průmyslu 

V obci je klasifikována jako budova pro průmysl místní výrobna textilu 

Schoeller. Celá jeho rozloha, která představuje 26 654 m
2
, by byla při povodňové 

situaci zaplavena. Výše škody dle Metodiky VÚV vychází z celkového statistického 

přehledu ČSÚ pro zpracovatelský a energetický průmysl. Hodnota majetku se 

v tomto případě určí jako součet dlouhodobého majetku, zásob a 1/3 pasiv 

z vlastního kapitálu firmy za poslední rok. Jednotková cena pro orientační určení 

škod v průmyslu je stanovena na 1m
2 

průmyslových budov a hodnota minimální 

škody je vyčíslena na 2 227 Kč/m
2
 (Drbal & kol., 2009).  

 

Vztah pro výpočet ztráty je následující: 

 

DP = A. ZP,  [Kč] 

kde 

A plocha objektu [m
2
] 

ZP ztrátová cena [Kč/m
2
] 
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Výše škody na objektu Schoeller by tedy byla 59 358 458 Kč a je shodná pro 

Q100 i Q500, jelikož by k zaplavení došlo při obou povodňových scénářích a vztah 

nezohledňuje výšku zaplavení. 

Škody na inženýrských sítích  

Při výpočtu škod na inženýrských sítích se vychází z předpokladu, že vedení 

těchto sítí je prováděno podél komunikací a proto se délka inženýrských sítí 

odvozuje od délky místních pozemních komunikací.  

 Výpočet ztrát je opět definován pomocí ztrátové ceny v Kč/m. Dle Metodiky 

VÚV, byly škody na inženýrských sítích v závislosti na daných ztrátových cenách 

pro jednotlivé kategorie stanoveny dle tabulky č. 7 takto:  

Inženýrské sítě Délka (m) 

Ztrátová 

cena min 

(Kč/m) 

Škoda (Kč) 

Elektřina 3700 12 44400 

Voda 3700 33 122100 

Kanalizace 3700 48 177600 

Plyn 3700 20 74000 

Telekomunikace 3700 12 44400 

  

Celkem: 462 500 Kč 

Tabulka č. 7, Škody na inženýrských sítích 

Výsledný odhad škody pro Q100 a Q500 na inženýrských sítích činí 462 500 Kč. 

Tento výpočet je vztažen pro sítě vedené podél hlavní silnice vedoucí obcí, která by 

byla zasažena povodní při Q100 i Q500, tudíž je výpočet totožný.  

 

4.6 Problémy při zpracovávání dat 

 Software HEC-RAS a jeho extenze HEC-GeoRAS pro zpracování modelu 

z prostředí HEC-RAS je freeware vyvinutý americkou armádou. Při zpracovávání 

analýzy v těchto platformách jsem čelila nejednomu problému s kompatibilitou. 

Domnívám se, že je velmi účelné tyto problémy popsat a zamezit tak dalším 

uživatelům těchto programů zbytečnému časově náročnému hledání řešení. 

První problém nastal při nahrávání datového výstupu z  HEC-RAS do prostředí 

HEC-GeoRAS při takzvaném post-processingu. Při kroku RAS Mapping -> Import 

RAS Data celý proces nedoběhl do konce a objevovala se chybová hláška dle 

obrázku č. 39.  
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Obrázek č. 39, Chybová hláška při importu dat zXML souboru vypracovaného v prostředí 

HEC-RAS 

Při prozkoumání zdrojových dat a vyhledání číselné hodnoty, na kterou se 

odkazovala chybová hláška XML dokumentu v poznámkovém bloku, se ukázalo, že 

z nějakého důvodu si extenze HEC-GeoRAS nedokázala poradit s desetinným 

oddělovačem a desetinnými hodnotami na řádku popisující Spatial Extent 

(prostorový rozsah dat, tedy souřadnicové určení řešené oblasti) (obrázek č. 40). 

Řešením tohoto problému bylo prosté vymazání desetinných číslic včetně 

desetinného oddělovače v XML dokumentu u hodnot pro vyjádření prostorového 

určení území.  

 

 

Obrázek č. 40, Desetinný oddělovač a desetinná místa u hodnot Spatial Extent v XML 

dokumentu způsobující chybovou hlášku 

Dalším problémem bylo získání rastru rychlostí při post-processingu. Při 

kroku RAS Mapping -> Velocity Mapping tento proces nikdy neproběhl do konce 

k získání požadovaného rastru rychlostí proudící vody. Výsledkem byla opět 

chybová hláška dle obrázku č. 41.   
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Obrázek č. 41, Chybová hláška při generování rastrové vrstvy rychlostí proudící vody 

Operace pro získání rastrové vrstvy rychlostí je analogická k vytvoření rastru 

hloubek vody, která vždy proběhla bez problémů. Po dlouhém hledání chyby nebo 

důvodu způsobujícího tuto hlášku bylo zjištěno, že rastr rychlostí bude vytvořen jen 

v případě, že se systémové nastavení desetinného oddělovače v systému Windows 

změní z tečky na čárku. V XML dokumentu, ze kterého byly zpracovávány extenzí 

HEC-GeoRAS numerické hodnoty, bylo dále nutné změnit manuálně desetinný 

oddělovač z tečky na čárku pro hodnoty, které měly zobrazovat numerické hodnoty. 

Po tomto přenastavení proběhl proces tvorby rastrové vrstvy reprezentující rychlosti 

proudící vody v pořádku.  

Systém Windows, ve kterém byla analýza zpracovávána, byl nastaven tak, 

aby jako desetinný oddělovač byla považována tečka a nastavení desetinného 

oddělovače na tečku je dokonce povinným krokem při práci s programem HEC-

RAS. Hodnoty ve výstupním XML dokumentu z programu HEC-RAS v případě, že 

obsahovaly desetinná místa, byly tedy odděleny desetinnou tečkou a jejich načtení 

proběhlo v pořádku až na načtení hodnot rychlostí. Proto opodstatnění výskytu této 

chybové hlášky nebylo nikdy zdůvodněno. 

5. Výsledky 

 Výsledkem této diplomové práce jsou mapy povodňových nebezpečí a rizik 

pro obec Křešice na Litoměřicku, kterým předcházelo vyhotovení mapy funkčních 

ploch obce, zranitelnosti a ohrožení. Jelikož byla v obci v roce 2011 dokončena 

výstavba protipovodňové ochrany na Q20, byla tato skutečnost brána v potaz a v této 

diplomové práci byly tedy vypracovány výsledné mapy nebezpečí a rizik ve dvou 

variantách. Jedna pro případ, že by obec neměla vystavěnou protipovodňovou 

ochranu a druhá, která hodnotí účinnost této ochrany. V obou případech byly 

zpracovány hydrologické informace pro Q5, Q20, Q100 a Q500. 

5.1.1 Mapy povodňového nebezpečí 

Povodňové nebezpečí bylo vizuálně vyjádřeno charakteristikami jako jsou 

rozsah rozlivu vody, hloubka a rychlosti vody v území při uvažovaných 
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povodňových scénářích. Následná vizualizace výsledků při zohlednění 

protipovodňové ochrany potvrdila její účinnost a opodstatněnost. Při Q5 a Q20 voda 

 z toku nepřesáhla hranici protipovodňové stěny. Tento fakt je vidět na obrázku č. 42, 

na kterém je jeden z příčných řezů z programu HEC-RAS a kde protipovodňová 

ochrana zabraňuje při Q5 a Q20 rozlivu vody do okolí. Naopak varianta výpočtů bez 

zohlednění této bariéry prokázala, že v případě, že by obec nedisponovala ochranou 

v podobě protipovodňové stěny, došlo by k závažnému zasažení obce vodou již při 

Q5. Podobný scénář by nastal i při Q20 a při Q100 a Q500 by byla zasažena naprostá 

většina území obce. Při Q100 a Q500 by došlo k zaplavení obce s podobným průběhem 

hladin pro obě varianty výpočtů.  

 

Obrázek č. 42, Funkčnost protipovodňové ochrany 

5.1.2 Mapy povodňového ohrožení a rizik 

 Pozoruhodným výsledkem je rovněž fakt, že konečná mapa ohrožení  

a posléze i mapa rizik vyšla pro variantu se zohledněním i bez zohlednění 

protipovodňové ochrany identicky. Důvodem tohoto faktu je skutečnost, že při 

vyhodnocování povodňového rizika se vybírá maximální hodnota z buněk 

charakterizující ohrožení v daném místě ze všech uvažovaných scénářů. Takže 

pokud určité místo nebude zaplaveno při Q5 nebo Q20, dojde k jeho zaplavení při 

Q100 nebo při Q500. A výsledná hodnota je tedy určena povodňovým scénářem při 

Q100 a zbylé nižší hodnoty nejsou brány v úvahu. Výsledná mapa ohrožení je 

v uvedena v příloze č. 12 a mapa rizika v příloze č. 13 této diplomové práce.  

 Díky vytvoření mapy povodňového rizika, která vychází z mapy ohrožení, by 

bylo přijatelné riziko ohrožení překročeno u 220 domů z celkového počtu 626. Toto 

riziko by bylo překročeno také u plochy sportoviště, z občanské vybavenosti u školy, 

mateřské školky, hřbitova, místní knihovny, kostela Navštívení Panny Marie  

a sv. Matouše v Křešicích, obecního úřadu, policejní stanice, pošty, ordinace 
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praktického lékaře a sboru dobrovolných hasičů Křešice. Z technické vybavenosti by 

byla zasažena skládka, čistírna odpadních vod a inženýrské sítě společně  

s komunikacemi v délce 3700 m a železnice v délce 2500 m. V neposlední řadě by 

došlo k zasažení orné půdy a výrobních ploch ve výměře 225,7 ha, což odpovídá 

jedné čtvrtině výměry z katastrálního území obce.  

 Pro obec Křešice byly také stanoveny výše škod takzvanou kvantitativní 

analýzou. Při této analýze bylo předpokládáno, že obec je dostatečně chráněna proti 

zaplavení při Q5 a Q20 a výše potenciálních škod byly stanoveny pro povodňové 

scénáře způsobené Q100 a Q500. Při tomto kroku bylo zjištěno, že rozdíl mezi 

povodňovými škodami pro Q100 a Q500 není markantní. Povodňové škody by při Q100 

dosáhly na 280 mil. Kč a při Q500 na 283 mil. Kč (viz obrázek č. 43).  

 

 

Obrázek č. 43, Výsledné škody pro Q100 a Q500  

Díky analýze ohroženosti návrhové plochy pro bydlení bylo zjištěno, že by tato 

plocha čelila střední a vysoké míře ohrožení při průtoku vyšším, než je Q20. 

 Prostorové vyjádření veličin určující povodňové nebezpečí, výsledky 

intenzity povodně, ohrožení, zranitelnosti a mapa rizika jsou součástí přílohy této 

diplomové práce.  

6. Diskuze 

 Výsledná mapa ohrožení obce pro variantu bez protipovodňové ochrany  

a s protipovodňovou ochranou vyšla identicky. Důvodem této skutečnosti je fakt, že 

pro vytvoření mapy rizik se pro dané místo vybírá hodnota nejvyššího dosaženého 

ohrožení při povodňových scénářích Q5, Q20 ,Q100 a Q500. Pokud tedy nezasáhne 

zvýšená hladina vody místo při Q5 nebo Q20, dochází zde ale k zaplavení tohoto 
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místa při Q100 nebo Q500. Tato skutečnost je dle mého názoru slabým místem 

Metodiky VÚV pro vytváření map povodňových nebezpečí a rizik. 

 Domnívám se, že dalším vysvětlením pro tuto skutečnost je způsob 

vyhodnocování výšky hladiny vody v záplavovém území v programu HEC-RAS. 

Tento software určuje výšku vody pro celý profil rovnoměrně a systémem plnění 

vodou je takový, že se voda v profilu plní od zdola do výšky pomyslné hladiny. 

V případě, že je v řešeném území instalována bariéra, která má zabránit rozlivu vody 

do okolí a hladina specifikovaného průtoku tuto bariéru překoná, je voda v profilu za 

bariérou vyplněna plošně v celé části profilu stejně a to od povrchu země k hladině. 

PPO zcela jistě změní výšku hladiny a hodnoty rychlosti vody za touto bariérou. 

Proto výsledky hloubek a rychlostí vody vyšly pro variantu se zohledněním PPO  

i bez jejího zohlednění totožně. Na druhou stranu je nutné zdůraznit, že při průtocích 

jako je například Q500 je hladina vody v takové nadmořské výšce, že by 

pravděpodobně došlo k velmi podobnému průběhu zaplavení, jako je simulován 

matematickým modelem.  

 Dalším aspektem k zamyšlení je problematika hodnocení povodňového 

ohrožení v případě N-letosti > 300. Veškeré ohrožení vyvolané povodňovými scénáři 

při Q300 a vyššími je klasifikováno v Metodice VÚV jako ohrožení reziduální. Dle 

mého názoru by mělo být toto ohrožení hodnoceno obdobně jako u průtoků s větší 

pravděpodobností výskytu, jelikož i při takto velmi ojedinělých průtocích dochází 

k enormním škodám.  

V Metodice VÚV jsou určovány výše škod na určitých kategoriích funkčních 

ploch. Bohužel zde chybí vyčíslení nebo alespoň odhad škod na památkách či 

historických objektech. Pravdou zůstává, že toto hodnocení by bylo příliš subjektivní 

vzhledem k rozdílné kulturní hodnotě každého takového objektu. Rovněž psychická 

újma z povodňové události na obyvatelstvo není specifikována.  

 Při porovnání výsledků rizikové analýzy, která byla prováděna v této 

diplomové práci, s výsledky analýzy DHI a.s. bylo zjištěno, že se výsledné mapy 

rizik liší jen nepatrně a to hlavně v míře ohrožení pro funkční plochu výroby 

představovanou firmou Scholler. Dle mapy povodňových rizik od DHI je tato plocha 

výrobny označována jako plocha s přijatelným rizikem, dle mého výsledku vyšla tato 

plocha jako plocha se středním ohrožením. Je zvláštní, že plocha této výrobny je 

v mapě povodňového ohrožení klasifikována povodňovým ohrožením reziduálním, 

ačkoliv ostatní plochy obklopující tento objekt mají stanovenou míru ohroženosti 

jako střední až vysokou (viz obrázek č. 44). Výsledky se mohou lišit z důvodu 

rozdílných softwarů, ve kterých byla analýza prováděna anebo rozdílným pracovním 

přístupem při vytváření podkladů.  
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Obrázek č. 44, Výrobní objekt firmy Scholeller v mapě rizika od DHI, 

http://hydro.chmi.cz/cds/?id=124&lang=cs&presenter=CDSMap&wmapp=CDS&wmap=c

ds_project_124_mpo#center=-728927.5,-994957.5&zoom=3 

7.  Závěr  
 Tato diplomová práce na základě zpracování hydrologických podkladů  

a dalších podkladů vztahujících se k řešené lokalitě – tedy ke katastrálnímu území 

obce Křešice na Litoměřicku, kompletně zmapovala povodňové nebezpečí a riziko 

spojené s povodňovými scénáři při průtocích Q5, Q20, a rovněž byly vyčísleny výše 

potenciálních škod pro Q100 a Q500.  

Díky této diplomové práci byla vytvořena vlastní podrobná metodika, která 

popisuje postup práce při vyhotovování map povodňových nebezpečí a rizik pro 

konkrétní obec v programu HEC-RAS a HEC-GeoRAS. Celá práce se opírá  

o odbornou Metodiku tvorby map povodňových nebezpečí a rizik vydanou 

Výzkumným ústavem vodohospodářským T.G. Masaryka a díky literární rešerši 

další dostupné odborné literatury z této oblasti popisuje řešenou problematiku 

komplexně. 

Kromě těchto přínosů práce rovněž přispěla při hledání řešení problémů, 

které se vyskytují při práci se specializovaným softwarem HEC-RAS a extenzí pro 

ArcGIS Hec-GeoRAS při použití v systému Windows s  nastavením pro Českou 

republiku. Návod na řešení problému se softwarem bylo umístěno na fórum firmy 

ESRI, kde již získalo několik pozitivních reakcí od uživatelů, kteří čelili podobným 

potížím. 
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Neméně důležitý je také výsledek digitálního zpracování funkčních ploch pro 

katastrální území obce Křešice. Obec stále nemá vyhotovený digitální územní plán  

a výsledek této části – tedy digitálního plánu funkčního uspořádání území, je možné 

využít při budoucí tvorbě digitálního územního plánu. 

 Jako přínos se jeví i ověření funkčnosti protipovodňové ochrany obce. Díky 

této práci byla potvrzena funkčnost této ochrany a prokázáno opodstatnění jejího 

vybudování. 

 V neposlední řadě je možné mapy povodňového rizika této práce porovnat 

s výsledkem DHI a odstranit odchylky a tím zpřesnit výsledky práce. 
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